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Examples Overview

Example

Fluid

Pipes

Descriptions

Tank Blowdown - Begin-

ner

Nitrogen

An in depth discussion of model building in
AFT xStream. Models a simple valve open-
ing during a tank blowdown.

Gas Turbine Fuel Sys-
tem

Methane

11

A compressor is passing natural gas
through a heat exchanger before being
used in the combustion baskets of a tur-
bine system. This example evaluates the
effect the sudden closure of one of the 3
control valves has on the temperature of

the system. The effect of the Minimum
Number of Sections per Pipe parameter is
also shown.

High Pressure Steam -
Fluid Property Models

Steam

12

Two turbines in a high pressure steam sys-

tem are simultaneously valved shut as a
bypass line valve is opened. This model
demonstrates factors to know to evaluate
which fluid database to use in your system,
as well as demonstrating how to construct
a model in the isometric drawing mode.

High Pressure Steam -
Forces

Steam

14

Two turbines in a high pressure steam sys-
tem are simultaneously valved shut. This
model demonstrates the transient forces of
the steam within the system as well as the
effect that the transient duration has on
these forces. Finally, this example shows
how to export the force file once the forces
are obtained.

Frequency Analysis -
PFA

Methane

A frequency analysis is performed on a sys-

tem with a positive displacement com-
pressor to determine the acoustical
frequencies for the existing piping con-
figuration using the Pulsation Frequency

Analysis (PFA) module.




Tank Blowdown Example (Metric Units)

Summary

This example will give you the big picture of AFT xStream's layout and structure. To accomplish this pur-
pose, a model with two pipes and three junctions will be built to capture the system effects when a valve
is opened.

Topics covered

* Model building basics

* Entering pipe and junction data
* Entering transient data

* Graphing output results

Required knowledge

This example assumes the user has not used AFT xStream previously. It begins with the most basic ele-
ments of laying out the pipes and junctions and solving the transient system via the Method of Char-
acteristics (MOC).

Model file

The file listed below contains a completed version of this example and can be located in the Examples
folder as part of the AFT xStream installation. This file can also be downloaded from the AFT xStream
help site from the Tank Blowdown Example page:

* Metric - Tank Blowdown.xtr

Step 1. Start AFT xStream

»To start AFT xStream, click Start on the Windows taskbar and open AFT xStream. (This refers to the
standard menu items created by setup. You may have chosen to specify a different menu item).

After AFT xStream starts, the Startup window, as shown in Figure 1, appears. This window provides you
with several options before you start building a model: You can open a model that was recently worked
on, browse to a different xStream file, or browse to the xStream Example files. If you have a license for
the xStream PFA add-on module, it can be activated here. The Unit System can also be specified to use
US Only, Metric Only, Both with US Defaults, or Both with Metric Defaults. They can be set as the user
default at this time as well. You can also set the working fluid to AFT Standard Air or another recently
used AFT fluid. You can click the link to "Check for Latest Release" to go to the AFT website to see if you
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have the latest release of AFT xStream. You can also "Subscribe to Receive Notifications" of when
product maintenance releases are available, receive the AFT newsletter, etc. Finally, you can open avail-
able learning resources such as examples.

Note: Be sure to specify either "Metric Only" or "Both with Metric Defaults" and check the box to "Set
As My Default." Also be aware that the first time xStream is started, the Startup window will not
appear as it does in Figure 1, as the center panel will be occupied by modeling preferences.

AFT xStream”

Acivale Modues (cense needed)

[J PFA (Pulsation Frequency Analysis) Check for Latest Release

elect Working Fluid Subscribe to Receive Notifications
® | Will Select Fluid Later Help Files
O Use AFT Standard "Air"
(O Select A Recently Used Fluid Open Help File (US & Metric)

QOpen Example Help (US) (Metric)
File with Descriptions

Other Files Modeling Preferences Video Tutorials

Units: All US and Metric units (Metric defaults) Show List of Available Online
Language: Englich Video Tutorials (internet)
Interface: 2-D workspace, grid notshown
Default Pipe Material: None

Browse 1o a File...

Browse to Examples. .

Start Building Model

[ Dent Show This Startup Window Again

Figure 1: AFT xStream Startup window

Click "Start Building Model".

The Workspace window is initially the active window, as seen in Figure 2. The five tabs in the AFT
xStream window represent the five Primary Windows. Each Primary Window contains its own toolbar
that is displayed directly beneath the Primary Window tabs.

AFT xStream supports dual monitor usage. You can click and drag any of the five primary window tabs
off of the main xStream window. Once you drag one of the primary windows off of the xStream window,
you can move it anywhere you like on your screen, including onto a second monitor in a dual monitor con-
figuration. To add the primary window back to the main xStream primary tab window bar, simply click the
"X" button in the upper right of the primary window.

To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT xStream settings, unless you are specifically instructed to do otherwise.
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The Workspace window

The Workspace window is the primary interface for building your model. This window has three main
areas: the Toolbox, the Quick Access Panel, and the Workspace itself. The Toolbox is the bundle of tools
on the far left. The Quick Access Panel is displayed on the far right. It is possible to collapse the Quick
Access Panel by clicking on the thumbtack pin in the upper right of the Quick Access Panel in order to
allow for greater Workspace area. The Workspace takes up the rest of the window.

You will build your pipe flow model on the Workspace using the Toolbox tools. The Pipe Drawing tool, on
the upper left, is used to draw new pipes on the Workspace. The Annotation tool allows you to create
annotations and auxiliary graphics.

Below the two drawing tools are icons that represent the different types of junctions available in AFT
xStream. Junctions are components that connect pipes and also influence the pressure or flow behavior

of the pipe system. The junction icons can be dragged from the Toolbox and dropped onto the Work-
space.

When you pass your mouse pointer over any of the Toolbox tools, a tooltip identifies the junction's func-
tion.

AFT xStream - Untitled (Workspace)

File Edit View Analysis Tools Library Amange Window Help

BR& R 008

3 Search

Pl & @ & EDAnalysisSetup.. | o Run Model

“Warkspace | {8 Model Dato | [ Output | [ Groph Results | ® Visuol Report |

K@ -

<
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X -4
=)
P
Wl B
W a
[maRec}
o Notes

L]

v
+uScenario | EZ|Properties

Base Scenario ¥ Q 100% | O B =0 | o0 || & oveviewMap (=] Add-on Modules @

Figure 2: The Workspace window is where the model is built

Step 2. Lay out the model

To lay out the tank blowdown model, you will place a Tank junction, a Valve junction, and an Assigned
Pressure junction on the Workspace. Then you will connect the junctions with pipes.

l. Place the Tank junction

»To start, click and drag a Tank junction from the Toolbox and drop it on the Workspace. Figure 3
shows the Workspace with one Tank.
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Objects and ID numbers

Items placed on the Workspace are called objects. All objects are derived directly or indirectly from the
Toolbox. AFT xStream uses three types of objects: pipes, junctions and annotations.

All pipe and junction objects on the Workspace have an associated ID number. For junctions, this num-
ber is, by default, placed directly above the junction and prefixed with the letter "J". Pipe ID numbers are
prefixed with the letter "P". You can optionally choose to display either or both the ID number and the
name of a pipe or junction. You also can drag the ID number/name text to a different location to improve
visibility.

The Tank you have created on the Workspace will take on the default ID number of one. You can change
this to any desired number greater than zero, but less than 100,000.

Editing on the Workspace
Once on the Workspace, junctions can be moved to new locations and edited using the features on the

Edit menu. Cutting, copying, and pasting are all supported. Undo is available for most formatting and
arrangement actions on the Workspace.

Note: The relative location of objects in AFT xStream is not important. Distances and heights are
defined through dialog boxes. The relative locations on the Workspace establish the con-
nectivity of the objects, but have no bearing on the actual length or elevation relationships.

Workspace o x

P - @ IkiMhea-a ) B ¢

Base Scenario B Q 100% | £ +0/| 01

Figure 3: Tank junction placed

Il. Place the Valve junction

»To add a Valve junction, click and drag a valve from the Toolbox and place it on the Workspace as
shown in Figure 4. The Valve will be assigned the default number "J2".
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P - @ Ixk[Mmea -a % E ¥

Base Scenario b G 100% | S } 0| @2

Figure 4: Tank Blowdown model with Valve placed

lll. Place an Assigned Pressure junction

»To add an Assigned Pressure junction, click and drag an Assigned Pressure junction from the Tool-
box and place it on the Workspace as shown in Figure 5. The Assigned Pressure junction will be
assigned the default number "J3".

»Before continuing, save the work you have done so far. Choose Save As... from the File menu
and enter a file name (Tank Blowdown, perhaps) and AFT xStream will append the ".xtr" extension to the
file name.
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P - @ (ke -a ) B ¥

Base Scenario b G 100% | S } | +0| @3

Figure 5: All junctions placed

IV. Draw a pipe between J1 and J2

Now that you have all of the junctions, you need to connect them with pipes.

»>To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The pointer will change to a
crosshair when you move it over the Workspace. Draw a pipe above the junctions by clicking and drag-
ging the mouse, similar to that shown in Figure 6.

The pipe object on the Workspace has an ID number (P1) that is shown near the center of the pipe.
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P - @ (ke -a ) B ¥

Base Scenario b G 100% | S } | +1| @3

Figure 6: First pipe drawn

»To place the pipe between J1 and J2, use the mouse to grab the pipe in the center and drag it so
that the left endpoint falls within the J1 Tank icon, then drop it there (see Figure 7). Next, grab the right

endpoint of the pipe and stretch the pipe, dragging it until the endpoint terminates within the J2 Valve
icon (see Figure 8).

\orkspace

P - @ k(M e-Mm h: B ¢

Figure 7: First pipe partially connected
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Figure 8: First pipe fully connected

Reference positive flow direction

Located on the pipe is an arrow that indicates the reference positive flow direction for the pipe. AFT
xStream assigns a flow direction corresponding to the direction in which the pipe is drawn. You can
reverse the reference positive flow direction by choosing Reverse Direction from the Arrange menu or
selecting the Reverse Pipe Direction button on the Workspace Toolbar.

The reference positive flow direction indicates which direction is considered positive. If the reference pos-
itive direction is the opposite of that obtained by the Solver, the output will show the flow rate as a neg-
ative number.

V. Add the remaining pipe

A faster way to add a pipe is to draw it directly between the desired junctions.

»Activate the Pipe Drawing Tool again. Position the cursor on the J2 Valve, then press and hold the
left mouse button. Stretch the pipe across to the J3 Assigned Pressure junction, then release the mouse
button. All objects in the model should now be graphically connected as they are in Figure 9.

Save the model by selecting "Save" in the File menu, by clicking the "Save" icon on the Toolbar, or by
entering Ctrl+S.

Note: It is generally desirable to lock your objects to the Workspace once they have been placed. This
prevents accidental movement and disruption of the connections. Locking also helps prevent
accidental deletion of your output once a solution has been completed. You can lock all the
objects by choosing Select All from the Edit menu, then selecting Lock Object from the Arrange
menu. The Lock Object button on the Workspace Toolbar will appear depressed indicating it is
in an enabled state, and will remain so as long as any selected object is locked.

-11 -
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P - @-Ix[Mea -a % E ¥

Figure 9: All pipes and junctions placed

A. Define the model components

Object status

Each pipe and junction has an object status. The object status tells you whether the object is defined
according to AFT xStream's requirements. To see the status of the objects in your model, click the light
bulb icon on the Workspace Toolbar (alternatively, you could choose "Show Object Status" from the View
menu). Each time you click the light bulb, "Show Object Status" is toggled on or off.

When "Show Object Status" is on, the ID numbers for all undefined pipes and junctions are displayed in
red on the Workspace. Objects that are completely defined have their ID numbers displayed in black.
(These colors are configurable through User Options from the Tools menu.)

Because you have not yet defined the pipes and junctions in this model, all the objects' ID numbers will
change to red when you turn on "Show Object Status."

Showing undefined objects

Another useful feature is the List Undefined Objects window (Figure 10). This can be opened from the
View menu by clicking on "List Undefined Objects", or by clicking the List Undefined Objects icon on the
Workspace toolbar . All objects with incomplete information are listed. Click on an undefined pipe or
junction to display the property data that is missing. Click the close button on the bottom right to stop
showing this window.

-12 -
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=~ Undehned Fipes -3
2 Fipe

I Undefined Junchions

»

1 Tank
2 Walve
3 Assigned Pressure

&= Undefined Properties for Pipe 1:

Fipe Length
Fipe Inner Diameter
Roughness./Friction

ol

Hsaveal.. Eoycopvan B 5 ®

Figure 10: The List Undefined Objects window lets you see the undefined properties for each undefined
object

l. Enter data for Tank J1

As shown in Figure 9, the J1 junction is a Tank junction.

»To define the first tank, open the J1 Tank Properties window (See Figure 11) by double-clicking on
the J1 icon. Choose the Finite Tank Model, then enter an Elevation of 0 meters. You can assign any unit
of length found in the adjacent drop down list.

Note: You can also open an object's Properties window by selecting the object (clicking on it) and then
either pressing the Enter key or clicking the Open Pipe/Junction Window icon on the Workspace
Toolbar.

>Enter a Pressure of 45 bar, @ Temperature of 150 deg. C, and a Volume of 8 5 meters3. Also set the
Initial Conditions to Known and the Thermodynamic Process to Adiabatic.

Note: You can specify default units for many parameters (such as feet for length) in the User Options
window, accessed from the Tools menu under Preferred Units.

By default, the junction's name is the junction type. The name can be updated by entering it in the Name
field at the top of the window. In Figure 11, the name of Tank J1 is "Supply Tank." The name can be dis-
played on the Workspace, Visual Report, or in the Output.

-13 -
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Most junction types can be entered into a custom Junction Library allowing the junction to be used mul-
tiple times or shared between users. To select a junction from the custom library, choose the desired junc-
tion from the Library List in the junction's Properties window. The current junction will get the properties
from the library component.

The "Copy Data From Jct..." list will show all the junctions of the same type in the model. This will copy
desired parameters from an existing junction in the model to the current junction.

The Tank Model tab is the tab that appears first when the Tank junction is opened and contains all of the
inputs required to define the Tank in steady-state. While the Tank Model tab is specific to the Tank junc-
tion, the first tab opened for any junction will contain all inputs required for that junction to be defined.

The Optional tab allows you to enter different types of optional data. You can select whether the junction
number, name, or both are displayed on the Workspace. Some junction types also allow you to provide a
guess for initial pressure as well as other junction specific data. The junction icon graphic can be
changed, as can the size of the icon. Design factors can be entered for most junctions, which are applied
to the pressure loss calculations for the junction in order to give additional safety margin to the model.

Each junction has a tab for notes, allowing you to enter text describing the junction or documenting any
assumptions.

The highlight feature displays all the required information in the Properties window in light blue. The high-
light feature is on by default. You can toggle the highlight off and on by double-clicking anywhere in the
window or by pressing the F2 key. The highlight feature can also be turned on or off in the User Options
window, or accessed from the View menu by selecting the "Highlight in Pipe and Jct Windows" option.

The Status tab will state whether all required input data is present for a given junction. If not, it will list all
inputs that are incomplete.

»Click OK. If "Show Object Status" is turned on, you should see the J1 ID number turn black again,
telling you that J1 is now completely defined.

- 14 -
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Tank Properties

Number: o OK

Name: |Supply Tank v | Ed Cancel
Library Jt: « | Hevation

S Jump..
Copy Data From Jct... w D meters R

2 Help

Tank Model | Optional esignflerts | MNotes | Status

Tank Model
O Infinite
® Finite

Initial Conditions

Pressure: bar -
(® Temperature:

150 w
O Erthalpy: deg.C
Finite Tank Parameters

Fixed Volume: metersd ~
Initial Conditions

@) Known

() Caleulate From Steady State

Thermodynamic Process

(® Adiabatic

) Isothermal

(O Known Heat and Volume vs. Time

Figure 11: Properties window for Tank J1

The Inspection feature

You can check the input parameters for J1 quickly, in read-only fashion, by using the Inspection feature.
Position the cursor on the Tank J1 junction and hold down the right mouse button. An information box
appears, as shown in Figure 12.

Inspecting is a faster way of examining the input (and output, if output results are available) than opening
the Properties window.
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rkspace o x
. s am « =
l 11 - SUPPLY TANK L] S
Name Supply Tank -~
- AEE Elevation 0 meters
Pressure 45 bar
O D Temperature 150 deg. C
I@ 6 Tank Model Finite
Volume 8.5 meters3
[ ] E] Thermodynamics Adiabatic
Heat Units kW
J1
? B Supply| Initial Conditions Known
Tank 43
@ D—)q Transient Method Accuracy Standard
O ~ @
o
[ v
o A
t v
< >
Base Scenario He G 100% | S Lt E | =0 | H1

Figure 12: Inspect junction properties from the Workspace by clicking and holding the right mouse button

Il. Define Valve J2

»O0pen the J2 Valve Properties window (see Figure 13) and enter an elevation of 0 meters.

»>Choose the loss model as K,, and enter a K, value of 52. This typically represents the valve's K,, dur-
ing steady-state. When the valve is closed during the steady state then opens during the transient (as is
the case for this model), the loss model represents the valve's loss at the end of the transient. Enter an Xt
of 0.7.

»Click on the Optional tab and, under Special Condition, select Closed. This indicates the valve will be
closed in the steady state.

»>Click the Transient tab and enter the data below for K (See Figure 14).

Time (seconds) K, X
0 0 0.7

0.1 52 0.7

240 52 0.7

The first data point (K,, = 0) must match the steady-state value. The transient data represents the valve
initially closed. The valve then opens over a period of 0.1 seconds and stays open.

Note: The initial transient data point is K,, = 0 because we set the Special Condition as Closed under
the Optional Tab. Had we selected none for the special condition, the first data point would have
to be K, = 52.

The J2 Valve is the element which causes the transient in this model. The purpose of the model will be to
understand how the conditions within the supply tank and discharge pipe change after the valve opens.
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When transient data is entered for a junction, an "XT" symbol is shown next to the junction number on the
Workspace.

Valve Properties

Number 2 Upstream Pipe 1 o« OK

Name- |Valve Vl Downstream Pipe: 2 m —
Hevation
Library Jt: v 4
j meters = ¥ Jump..
Copy Data From Jet ... ~ =
) Help

Loss Model | Transient | Optional | DesignAlerts | Netes | Stetus

Subsonic Loss Model Loss Source

(O Cv (ANSIASA) |2 (®) Fixed Kv

® Kv (C) From Open Percent Table

{on Optional Tab)

o -

Open Percentage Data

Open Pct Ky Flow Area ¥ |~ |F EdtTable -
Show Graph...
Create Kv/Open’..

v Optional Data

Flow Area Units: | meters2 ~ Open Pet Increment: Autofill

||

[ Exit Valve (optional)

Figure 13: Input data for Valve junction J2
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lll. Define Assigned Pressure J3

»O0pen the J3 Assigned Pressure Properties window (see Figure 15) and enter an Elevation of 0

meters.

Valve Properties

Mumber: ] Upstream Pipe 1
Name: |va|‘,E "| Downstream Pipe: 2
Hevation
Library Jet
meters ~
Copy Data From Jct -
Loss Model | [ Transient |  Optional | Designlerts | Nofes | Status

Transient Special Condtion
(® Mone

() Ignore Transient Data
Initition of Transient

® Time (O Dual Event Cyclic
(O Single Event (O Dual Evertt Sequertial

Transient Data
(® Absolute Values
() Relative To Steady-State Value
(O Open Percentage

€

% Source

® User

0K
Cancel

Jump.

) Help

QO Open ™ Table

Fill ¥ from table

Dats | Time
Point | (seconds) Ky

1 0 0
2 0.1 52
3 240 52
4

5

6

7

g

i

10

1

12

13
[ EdtTable = | Show Graph

[ Repeat Transient

M Transient

Xt

Figure 14: Transient input data for Valve junction J2

»Enter a Stagnation Pressure of 1 bar and a Stagnation Temperature of 21.1 C.

»Save the model again before proceeding.
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Assigned Pressure Properties

Name: |Assigned Pressure v| Cancel
Library Jct: w EmgE B dump...

Copy Data From Jet... -
& Help

Pressure Model | Loss Coefficient | Transient | Optional | DesignAlerts | Motes | Status
Boundary Specification
(®) Stagnation (O Static
Stagnation Pressure: bar e
(®) Temperaturs
() Enthalpy

]

Stagnation 11 deg.C s

Figure 15: Enter the data for Assigned Pressure J3 in the Assigned Pressure Properties window

IV. Define Pipe P1

The next step is to define all the pipes. Double-click the pipe object on the Workspace.

»>First, open the Pipe Properties window for Pipe P1. For Pipe P1, enter a length of 6.1 meters, and
select the Material as Steel - ANSI, nominal 2 inch size, STD (schedule 40) (see Figure 16).
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Pipe Properties

MNumber: Upstream Junction: 1 of OK
Name: |PiDe .| Downstream Junction: 2 m Cancel
Copy Data From Pipe... ~ Jump.
2 Help
Pipe Model | Fittings &Losses | Heat Transfer | DesignAlerts | Optional | Notes Status
Size Length

Pipe Material: | Steel - ANSI
Size: Zinch

Type STD (schedule 40)

Inner Diameter; 5.250179 cm

[] ID Reduction {Scaling):

<4<«

Friction Model
Data Set
OaLI . Absolute Roughness ~ Load Default
ISEr JpECTIE:

® | Standard " 0.004572 cm ~

Figure 16: Properties window for Pipe P1

The Pipe Properties window offers control over all important flow system parameters that are related to
pipes.

The Inspect feature also works within the Pipe Properties window. To inspect a connected junction, pos-
ition the mouse pointer on the connected junction's ID number and hold down the right mouse button.

This is helpful when you want to quickly check the properties of connecting objects. (You can also use
this feature in junction Properties windows for checking connected pipe properties.)

By double-clicking the connected junction number, you can jump directly to the junction's Properties win-
dow, or you can click the Jump button to jump to any other part of your model.

Click OK to finish defining P1.

V. Define Pipe P2

»Open the Pipe Properties window for Pipe P2. Enter a length of 457 meters, and select the Material
as Steel - ANSI, nominal 2 inch size, STD (schedule 40).

Check if all the pipes and junctions are defined by clicking on the List Undefined Objects button. If all data
is entered, no items should appear in the Undefined Objects window. If items are present, open the cor-
responding Properties windows for the incomplete items from the workspace. The Status tab on each
Properties window will indicate what information is missing.

B. Review model data

»Save the model. Itis also a good idea to review the input using the Model Data window.
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Reviewing input in the Model Data window

The Model Data window is shown in Figure 17. To change to this window, you can select it from the Win-
dow menu, you can click on the Model Data tab, or you can press Ctrl+M. The Model Data window gives
you a text based perspective of your model. Selections can be copied to the clipboard and transferred
into other Windows programs, exported into Excel, saved to a formatted file, printed to an Adobe™ PDF,
or printed out for review. Figure 18 shows an expanded view of the Transient Data tab from Figure 17.
Here all transient input data for the model is shown.

Data is displayed in three general areas. The top is called the General data section, the middle is the
Pipe data section and the bottom is the Junction data section. Each section is collapsible using the but-
ton at the top left of the section. Further, each section can be resized.

The Model Data window allows access to all Properties windows by double-clicking on any input para-
meter column in the row of the pipe or junction you want to access.

Model Data o x
Be-dhsS
A | General |Motes

Segments Per Pipe= 10

Mach Number Increment= 0.01

Pressure Tolerance= 0.0001 relative change

Mass Flow Rate Tolerance= 0.0001 relative change
Enthalpy Tolerance= 0.0001 relative change
Concentration Tolerance= 0.0001 relative change
Fow Relaxation= (Automatic)

Pressure Relaxation= (Automatic) Y]

a

# | Pipes | Pipe Fittings & Losses = Pipe Detail Summary

Pipe | Name | Pipe | Length | Length | Hydraulic | Hydraulic | Friction | Roughness | Roughness | Losses (K) | Initial Flow | Initial Flow | Junctions G

Defined Units | Diameter | Diam. Units | Data Set Units Units (Up.Down)

1 |Pipe Yes 6.1 meters 5250179 cm Standard 0.004572 cm o 1.2 Cyli

2 |Pipe Yes 457 meters 5.250179 cm Standard 0.004572 cm o 2.3 Cyli

£ >

A | AssignedPressure | Tank  Valve Transient Data
Assigned Pressure Name Object | Elevation = Elevation | Library | Pressure | Pressure | Pressure | Temperature/Enthalpy | Tempe
Defined Units Source Units Type

3 Assigned Pressure Yes 0 meters 1 bar Stagnation 21.1 deg. C

< >
Base Scenaric Q1o0% | O 1) +

Figure 17: The Model Data window displays all input in text form
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Model Data o x
4 e-8mn=S

A | General |Notes

Segments Per Pipe= 10 ~
Mach Number Increment= 0.01

Pressure Tolerance= 0.0001 relative change

Mass Flow Rate Tolerance= 0.0001 relative change
Enthalpy Tolerance= 0.0001 relative change
Concentration Tolerance= 0.0001 relative change
Fow Relaxation= (Automatic)

Pressure Relaxation= (Automatic)

o o i

# | Pipes | Pipe Fittings & Losses = Pipe Detail Summary
Pipe | Name | Pipe | Length | Length | Hydraulic | Hydraulic | Friction | Roughness | Roughness | Losses (K) | Initial Flow | Initial Flow | Junctions G
Defined Units | Diameter | Diam. Units | Data Set Units Units (Up.Down)
1 |Pipe Yes 6.1 meters 5.250179 cm Standard 0.004572 cm o 1.2 Cyli
2 |Pipe Yes 457 meters 5.250179 cm Standard 0.004572 cm o 2.3 Cyli
< >
A | Assigned Pressure | Tank | Valve | Transient Data
J2 (Valve) Transient Data:
Time Data
Time K Xt
0 0 07
0.1 52 07
240 52 07
Base Scenaric Q100% | 2 1) )

Figure 18: The Transient data tab in the Model Data window displays transient input data

Step 3. Specify Analysis Setup

»Next, click Analysis Setup on the Main Toolbar to open the Analysis Setup window (see Figure 19).
The Analysis Setup window contains six or more groups depending on which modules you may be using.
Each group has one or more items. A fully defined group has every item within it defined with all required
inputs. Complete every group to run the Solver. A group or item that needs more information will have a
red exclamation point to the left of the group or item name. After completing a group, the group icon
shows a green circle with a checkmark. After defining all groups, thus completing the Analysis Setup, the
Model Status light in the lower right corner of the Workspace turns from red to green.

The Analysis Setup window can also be opened by clicking on the Model Status Light on the Status Bar
at the bottom right corner of the AFT xStream window.
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Analysis Setup X
[®  Modules ~ | Fud
& | Fluid Properties & Flids Available in Library
| Fluid ® AFT Standard (O ASME Steam Tables O Chempak () NIST REFPROP
31 Pipes and Junctions A Name: o
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! Pipes and Junctions

Ammania

4k !  PipeSectioning and Output ~
Benzene

| Pipe Sectioning and Output Butane

Carbon Dioside v

@5 Transient Conirol ~

Addto Model
! Simulation Mode/Duraticn v redte Hose v

Fluids in Current Model

© Transient Solver Inifial
59  Forces ~
AFT Armow ™ Steady
28 Solution v
£  Environmental Properties
E®  Miscellaneous ~
Specific Heat Ratio Source
Equation of State v oz [ @ Ubray O User
Evthalpy Mode! = C 1
Edé Fuid List
Calapse Al Groups = Same As Parert P Hep /oK B3 Cancel

Figure 19: The Analysis Setup window tracks the defined and undefined model input

A. Specify the Modules group

Under the Modules group, click on the Modules item to open the Modules panel, shown in Figure 19.
Here you can enable and disable the Pulsation Frequency Analysis add-on module. By default, the
model will have all modules disabled. Therefore, make no changes to this panel for this example.

B. Specify the Fluid Properties group

»Select the Fluid item to open the Fluid panel (Figure 20).

This panel allows you to specify the fluid used in the model.

You can select a fluid from the standard AFT xStream fluid library (AFT Standard), or select ASME
Steam Tables. Additionally, you can select multiple fluids and/or create mixtures using the included NIST
REFPRORP library or optional add-on Chempak library, or create custom fluids. Custom fluids are created
by opening the Library Manager from the Library menu or by clicking the Edit Fluid List button in the Fluid
panel and clicking "Add New Fluid...".

»Select the AFT Standard fluid option, then choose "Nitrogen (GN2)" from the list and click the "Add
to Model" button.
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Analysis Setup X
[19  Modues ~ | Fud
Modules
Fiids Available in Library
4O  Flid Properties ~ @ AFT Standard () ASME Steam Tables () Chempak () NIST REFPROP
© “Fluid Name ~
: ) Nerogen (GN2)
| e ~
Ol Fr=t Onygen 1GOZ)
| Pipes and Junctions Propane
; ; Propylene
¢!  Pipe Sectioning and Output ~ Refrigerart C-318
[ e Srrrmerd B Steam b

#31  Transient Conirol ~ v Addto Model v

Flids in Curent Model
Nitrogen (GN2)

¥ Simulation Mode/Duration

Transient Solver Initialization
F - Remove Fluid

e ‘Add to Library

Environmental Properties

L5
2 ATAmw Stedy "
=]
E=D

Miscellaneous ~ Specific Heat Ratio Source
Equation of State: | Redich-Kwong ~ @® Lbrary O User
Enthelpy Model: | Generalized |

Edit Fuid List.

Calapse Al Groups = Same As Parert P Hep /oK B3 Cancel

Figure 20: The Fluid panel is where you specify the fluid

C. Inspect the Pipes and Junctions group

The Pipes and Junctions group in the Analysis Setup window contains the Pipes and Junctions panel,
which is used to show the status of the pipes and junctions on the workspace. This item is incomplete if
there are any undefined pipes/junctions on the Workspace, or if there are no pipes/junctions on the Work-
space. In this example the objects in the Workspace are fully defined, so this item is marked as complete.

Running models in steady-state

After fully specifying the pipes and junctions, sufficient information exists to run the model in steady-
state. You can run the model in steady-state by selecting the Simulation Mode/Duration panel from the
Transient Control group and then choosing "AFT Arrow™ Steady" for the Time Simulation. If you do this,
the other inputs on the Simulation Mode/Duration panel and the Pipe Sectioning and Output panel will no
longer be required, and the model can be run.

In general, it is a good idea to always run your model in steady-state before running the full transient ana-
lysis to make sure the model is giving reasonable results. However, in this case the model has no flow in
the steady state, and a steady state run is trivial.

D. Specify the Pipe Sectioning and Output group

The next panel is the Pipe Sectioning and Output panel in the corresponding group. The Pipe Sectioning
and Output panel divides pipes into computation sections in a manner which is consistent with the
Method of Characteristics (MOC).

To satisfy the MOC, the following equation must be satisfied:
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- _ Az
Atmin = 2 CT,max

where Atis the time step, Axis the section length, and ¢ is the sonic velocity.
»Enter "1" for the Minimum Number of Sections Per Pipe

The Minimum Number of Sections Per Pipe determines the section length by taking the quotient of the
shortest pipe's length and the Minimum Number of Sections. The number of sections used will impact
both the accuracy and the run time - a larger number of sections will increase the result accuracy, but will
also quadratically increase the run time for the model. The Minimum Number of Sections will be defined
as 1 in this example for expediency, though this may result in a lower accuracy than when using more
sections. The error in the results due to this sectioning choice will be explored further in a later step.

»Define the Estimated Maximum Pipe Temperature During Transient as 930 deg. C.

The Estimated Maximum Pipe Temperature During Transient is used to calculate the maximum sonic
velocity. Since all pipes in the network must be solved together, the time step must be the same for each
pipe. However, the sonic velocity will not be equivalent for all of the pipes. Therefore, the sonic velocity at
the specified maximum temperature is used to find a uniform time step for the system. Without a uniform
time step, the MOC could fail. Choosing a maximum temperature that is much higher or much lower than
the maximum temperature calculated during the run can result in additional uncertainty in the MOC solu-
tion, as is discussed in the Pipe Sectioning - Introduction to Method of Characteristics help topic. It is gen-
erally recommended to choose a conservatively high temperature for the model initially. The results of
the initial run can then be used to refine the Estimated Maximum Temperature During Transient for sub-
sequent runs.

The Sectioning Summary underneath the inputs will be partially filled in. Certain properties, such as total
steps and total pipe computations, need the Simulation Mode/Duration panel completed to be defined.

Anslysis Setup x
[7®  Modules v ‘ Pipe Sectioning and Output
[ Sl - Mirimum Number of Sections Per Fipe This value i related to aceuracy and rurtime. See the help file for detaiis
@ “Fluid Estimated Maximum Pipe Fuid Temperaturs During Transient T e )
B Fipes and.Junctions v
Pipe Stations To Include In Transient Output Fle
4H® Pipe Sectioning and Ouiput ~ O Inlet/Outlet Only
@ “Pipe Sectioning and Output @A
#31  Transient Conirol ~ Sectioning Summary
. ‘ Shorest Pipe: 6 10 meters Estimatsd Total Steps: —
¥ Simulztion Mode/Duration Ideal Section: 6.10 meters Total Statians: 76
Transisnt Solver Iniialization Estimatsd Max. Sonic Velocty: 639 83 meters./sec Estimatsd Total Pipe Computations: —

Estmated Tine Step: 4.421357¢-03 secands
59  Forces ~ =

|51 sectioning Details |

AFT Armow ™ Steady
29 Solusion h —
1 advanced Sectioning Centrols |

5  Environmental Properties
ED  Miscellancous v

<Stream Defaut

Callapse All Groups T Same As Parent P Hep o ok | [ cancel

Figure 21: The Sectioning panel in the Analysis Setup window is used to calculate the time step of the model
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E. Specify the Transient Control group

The Transient Control group has two items, the Simulation Mode/Duration panel and the Transient
Solver Initialization panel. The Simulation Mode/Duration panel allows you to choose the simulation type,
and to specify the time that the simulation starts and stops.

The Transient Solver Initialization panel contains advanced settings related to the resolving artificial tran-
sients in the model, and typically should not be changed.

»Select the Simulation Mode/Duration panel (Figure 22). Enter 0 seconds for Start Time and 240 for
Stop Time.

»Click OK to accept the current settings. The last Analysis Setup panel should be completed. The
model is ready to be solved.

Analysis Setup X

79 Modules ~ | Simulation Mode/Duration

5;0 Fluid Properties Bt Time Simulation

() AFT Amow™ Steady (@) Trangient
=89 Pipes and Junctions ~

Atransient simulation using the Method of Characteristics (MOC) will be run with user defined transients

. - enabled. A period of Atfficial Transient Resolution with transient junction behavior disabled will first be run to
4l  Pipe Sectioning and Output ~ avoid artificial transients from being propagated in the system.

@ “Pipe Sectioning and Output
= g P Simulation Duration

Transient Conirol Cad Start Time: D seconds ~

@ “Simulation Mode/Duration Stop Time:

Transient Solver Initialization
Forces ~

AFT Amow ™ Steady
Solution

Environmenial Properies

§® 8 F

Miscellaneous v

Collapse All Groups 7 Same As Parert P Hep of OK m Cancel

Figure 22: The Simulation Mode/Duration panel is used to specify the simulation type and the time span for
the transient

>»Save the model.

Step 4. Run the solver

»Choose "Run Model..."from the Analysis menu or click the "Run Model" button on the Main Tool-
bar. During execution, the Solution Progress window displays the state of the simulation (Figure 24). You
can use this window to pause or cancel the solver's activity.

Note the run time may take 5-10 minutes for this model, depending on your computer's speed.
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The two solvers

AFT xStream has two solvers. The first is called the AFT Arrow™ Steady Solver, which as its name sug-
gests, obtains a steady-state solution to the pipe network. The second solver is called the Transient
Solver and solves the gas transient equations.

The AFT Arrow™ Steady solver and Transient solver use different sectioning methods, which causes
small discrepancies between the converged AFT Arrow™ Steady solution and the first time step of the
transient solution. To allow artificial waves caused by these discrepancies to die out, AFT xStream runs
the Transient solver for a period of time before the transient simulation begins. Once the artificial tran-
sients have died out AFT xStream checks the solution with resolved artificial transients against the AFT
Arrow™ Steady solution. If the mismatch between the beginning and end of the artificial transient res-
olution process is sufficiently small AFT xStream proceeds with the transient simulation. See the chartin
Figure 23 as a visual representation of the process described above.

‘ Transient Solver Initialization »le—Transient Simulation

e

Arrow Resolved
Converged Solution

Resolving
Artificial Transients

AFT Arrow

v

Figure 23: lllustration of the Transient Solver Initialization process with artificial transient resolution

»When the solution is obtained, click the Output button to display the text-based Output window.
The information in the Output window can be reviewed visually on the screen, saved to a file, exported to
a spreadsheet-ready format, copied to the clipboard, or printed.
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Solution Progress - Complete

Maximum lerations: 50000 Run Time: 2231
Solution Method: Length March with Mach # Limit
Relaxation: Automatic Estimated Time Remaining:

Transient Parameters: Stop Time: 240 seconds, Time Step: 0.004421 seconds

Absolute Tolerance  Relative Tolerance Total tterations
Max Out of Tal. Max Out of Tal.
Pressure: 1.0E-04 Relative Change |D.DDDE+DD | |D.DDDE+DD | ||} |
Not used (Absolute Change bar)
Mass Flow Rate: 1.0E-04 Relative Change |D.DDDE+DD | |D.DDDE+DD | |2 |
Mot used {Absolute Change kg/sec)
Enthalpy: 1.0E-D4 Relative Change |0.000E+00 | [0.000E+00 | [2 |

Mot used (Absolute Change kJ/kg)
Transient

I

Pipe 2 had a final relative inlet to outlet difference in energy flow of 0% -

Setting up Transient Simulation with Resolved Solution as the inttial condition
Time step is 4.421357e-03 seconds
There are 76 total stations in the model
The simulation will run for 240.00 seconds and 54,281 time steps
4,125,356 total pipe computations will be required

Running Transient Simulation...

Calculations complete. he
Cther v n }( @ & =
Actions Cancel Graph Results... Visual Report... Qutput...

Figure 24: The Solution Progress window displays the state of the simulation

The transient output file

When the Transient Solver runs, the transient output data is written to a file. This file is given the same
name as the model itself with a number appended to the name, and with an ".out" extension appended to
the end. For all transient data processing, graphing, etc., the data is extracted from this file. The number
is appended because AFT xStream allows the user to build different scenarios all within this model. Each
scenario will have its own output file; therefore, the files need to be distinguishable from each other.

The output file will remain on disk until the user erases it or the model input is modified. This means that if
you were to close your model right now and then reopen it, you could proceed directly to the output win-
dow for data review without re-running your model.

Step 5. Review the Output window

Click Output after the solver is finished. The Output window (Figure 25) is similar in structure to the Model
Data window. Three areas are shown, and you can minimize or enlarge each section by clicking the
arrow next to the General, Pipes, and All Junctions tabs. The items displayed in the tabs can be cus-
tomized with the Output Control window from the Tools drop-down menu.

The General section will open by default to the Warnings tab if any Warnings or Cautions were
encountered during the simulation. This model should generate a Caution that the Maximum Transient
Pipe Mach Number is at least 0.2 higher than the steady pipe Mach number, which occurs since there is
no flow in the system at steady state. When this Caution is present, the effect of pipe sectioning on res-
ults can be significant. The impact of pipe sectioning will be addressed in greater detail later in Step 10.
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The Output window allows you to review both the steady-state and transient results. The Pipes tab, All
Junctions tab, and any specific junction tabs in the Junction section (such as Branch, Tank, Valve, etc.)
show the steady-state results. You can review the solutions for each time step (i.e., a time history) for
which data was written to file. Also, a summary of the maximum and minimum transient results for each
computing station is given on the Transient Max/Min tab in the pipe area. These two data sets are located
on the Transient Output tab and Transient Max/Min tab in the pipe area of the Output window (see Figure
26 and Figure 27). Note that in order to display all pipe stations as shown in Figure 26, the model will
need to be set to save data for all stations. By default, xStream saves all data points. This can be
changed in the Pipe Sectioning and Output panel.

Click on the Event Messages By Time tab (See Figure 28). There should be messages indicating that
Valve J2 experienced a near instantaneous choking that dissipated after about 0.06 seconds while
Assigned Pressure J3 experienced choking after 2.33 seconds that lasted until approximately T=128.9
seconds. Choking is an important phenomenon to pay attention to as it indicates that the fluid has

reached sonic velocity. This has significant implications for the MOC calculation method as will be dis-
cussed later.

Output o x
B E B R B

2 | General | Warnings | Design Alerts = Applied Standards = Event Messages By Jct = Event Messages By Time | Valve Summary = Tank Summary
Messages

For an explanation of Wamings, click an item in this list and press F1 or search for Wamings' in the Help system.

A  Pipes  Axial Points = Transient Qutput | TransientMax/Min | Heat Transfer

Max. Static Max. Static Max. Static | Min. Static Min. Static Min. Static | Max. Mass Max. Mass Max. Mass [ Min. Mas:
Pipe | Pressur Pressur Pressur Pressur Pressur Pressur Flowrate Flowrate Flowrate Flowrate
(bar) Time (seconds) Station (bar) Time (seconds) Station (ka'sec) | Time (seconds) Station (ka/sec)
1 4500 0.000 0| 6.2620 2400 1 7.793 0.1105 0| 0.000E+
2 40.58 2573 0| 0.5277 1289 75| 77719 0.1017 0] -1618E
< >
& | AllJunctions | Assigned Pressure  Tank | Valve
Jet MName Mass Flow Rate | dP Stag. | P Stag. | PStag. | P Static | P Static dT TStag. | TStag. | TStatic | T
(AFT Arrow Thru Jet Total In ut n Out Stag Inlet Outlet In
Steady) (ka/sec) (bar) (bar) (bar) (bar) (bar) (deg. C) | (deg. C) | (deg. C) | (deg. C) | (dv
1 Supply Tank 0 000 45000 45000 45000 45.000 0.0 15000 15000 150.00
X2 Walve 0 4400 45000 1000 45000 1.000 128 15000 2110 15000
3 Assigned Pressure 0 0.00 1.000 1.000 1.000 1.000 0.0 2110 2110 21.10
< >
Base Scenario Q10 | @ {} +)

Figure 25: The Output window displays steady and transient output in text form

A  Pipes Azl Points | Transient Output | Transient Max/Min = Heat Transfer

Step: 0 Static Mass Velocity Static
Time: 0.00000E+00 | Pressure | Flowrate Temperature
Pipe — Station (bar) | (kglsec) | (meters/sec) (deg. C)
i 1--0 45.000 0 0 150.00
2] 2-0 1.000 0 0 21.10
MW r|n '

Figure 26: The Output window displays transient data from each time step
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# | Fipes | Axial Points = Transient Output Transient Max/Min = Heat Transfer

Pips Name | Mass Flow Vel Vel. Mach | Mach | dP Stag. | P5tag. | PStag. | P Static | P Static dT T Stag.
(AFT Arrow Rate In Out #In | #0ut Total In Out In Out Stag Inlet
Steady) (kg/sec) | (meters/zec) | (meters/sec) (bar) (bar) (bar) (bar) (bar) (deg. C) | (deg. C)
1 Fipe 0 0 0 0 0 0 45000 5000 45000  45.000 0 15000
2 Fipe 0 0 0 0 0 0 1.000 1.000 1.000 1.000 0 2110
£ >

Figure 27: The Output window displays the values of steady-state parameters in the pipes tab

# | General  Warnings = DesignAlerts | Applied Standards | Event Messages By Jot | Event Messages By Time | Valve Summary | Tank Summary

“* Events Sorted By Jet Number

Valve Junction 2 became sonically choked at Time: 0.004421358 seconds

Valve Junction 2 lost sonic choking &t Time: 0.05747765 seconds

Assigned Pressure Junction 3 became sonically choked at Time: 2 334477 seconds
Assigned Pressure Junction 3 lost sonic choking at Time: 128.887 seconds

< >

Figure 28: The Output window displays event messages about system behavior in the Event Messages by
Time tab

A. Modify the output format

Go to the Transient Max/Min tab in the Output window. If you selected the default AFT xStream Output
Control, the Max. Mass Flowrate and Min. Mass Flowrate should have units of kg/sec (kilograms per
second).

»Select Output Control from the Tools menu or the main Toolbar. Open the Pipe Transient results
section. On the right side of the Pipe Transient results section is the list of currently selected output para-
meters (see Figure 29). Click and change the units by clicking the arrow beside the units, and then select-
ing kg/hr (kilograms per hour) from the drop down list.

»Click OK to display changes to the current results. You should see both the Max. Mass Flowrate
and Min. Mass Flowrate in units of kg/hr.

» Select Output Control from the Tools menu one more time. Open the Transients Results section.
The Reorder scroll bar on the far right allows you to reorder parameters in the list. You may also reorder
parameters by dragging and dropping the icon just to the left of each parameter within the list of currently
selected parameters.

»Select the Temperature Static parameter and use the Reorder scroll bar to move it up to the top of
the parameter list.

»Click OK to display the changes to the current results. You will see in the Transient Max/Min table
that the first column now contains Temperature Static. The Output Control window allows you to obtain
the parameters, units and order you prefer in your output. This flexibility will help you work with AFT
xStream in the way that is most meaningful to you, reducing the possibility of errors.

»Lastly, double-click the column header Max. Mass Flowrate in the Transient Max/Min tab. This will
open a window in which you can change the units once again if you prefer. These changes are extended
to the Output Control parameter data you have previously set.
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Output Control
Display Parameters | General | Format& Action | Show Pipesilcts

¥ Pipes | 1 Junctions | 47 Compressor/Fan | £ Valves | Ay Heat Exchangers | L Tanks | @ Cost Report | @ Heat Transfer

2 Pipe Transient

| Fiter | Show Output in This Order Reorder

Available Output Parameters Parameter Units ~

Beta A Temperature Static deg. C

Density Stagnation
Density Static
Elevation

Enthalpy Stagnation
Enthalpy Static

Gamma
Length Up To Station *

Mach Number

Mass Flowrate bl
Mass Fluid at Station

Mass Fluid Pipe Total

MName of Pipe

Pressure Stagnation

Pressure Static v
£ >

Pressure Static bar
Mass Flowrate kg/hr

£ 3L

T
|
1
T
|
1
T
|
1
T
|
1

<] <

WVelocity meters/sec

27 of 27 parameters shown (unfitered)

. Show
Alphabetical Description Remove Clear All Same Units... Use Prefered Units...

Load Control Format... User Default xStream Default o OK

@ Same As Parert Save Control Format.. Set as Default P Help m Cancel

Figure 29: The Output Control window allows for the modification of Parameters shown, Units, and the Order
of Results

B. Graph the results

For transient analysis, the Graph Results window will usually be more helpful than the Output window
because of the more voluminous data.

»Open the Graph Results window by choosing it from the Windows menu, clicking the Graph Results
tab, by clicking "Graph Results" from the Solution Progress window after running the model, or by press-
ing Ctrl+G.

The Graph Parameters menu will automatically be displayed in the Quick Access Panel on the far right of
the Graph Results window, and is where you can specify which graphs to generate. On the Transient

Pipe tab under Select Pipe Stations, expand P2 pipe stations and double-click, or click. * | (Add button)
the outlet station. This pipe computing station correlates to the pipe discharge for the Blowdown Tank
system. Select the Graph Parameter as Temperature Static and set the units to deg C. Add the Para-
meters Velocity and Mach Number (See Figure 30).
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B Transient Pipe B4 Transient Jct B4 Profile

Select Pipe Stations: Graph These Pipes/Stations:
=I- 2 (Fipe)
- Inlet
i Outlet
+- Other Stations z
Multi-Scenario. . . = || Current Only
Time Units: | seconds -

Time Frame: | (®) Al Times () User Spedified

Select Parameter or Add + X Remove @ ED
Parameter Linits DA
vw| Temperature Static ~| deqg.C - |:|
w| Velociy * | meters/sec - ]

b v MachNumber - - ]

Figure 30: The Graph Control tab on the Quick Access Panel allows you to specify the graph parameters you
want to graph in the Parameters/Formatting area

»Click the Generate button. The graph shows the temperature, velocity, and Mach number at the exit
for Pipe 2 (Figure 31).

You can use the other buttons in the Graph Results window to change the graph appearance and to save
and import data for cross-plotting. The Graph Results window can be printed, saved to file, copied to the
clipboard, or printed to an Adobe PDF file. The graph's x-y data can also be exported to a file or copied to
the clipboard.

Note that the graph guide, located at the top right of the Graph Results window and represented with the
What Would You Like to Do? icon, can guide you through the development of your graph. This feature
can be hidden by clicking on the icon.
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Graph Results o x

i
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Figure 31: The Graph Results window offers full-featured plot generation. The static temperature, velocity,
and Mach number of Pipe P2 outlet are shown.

Further review of the graph results in Figure 31 shows that sonic choking occurs after several seconds as
was seen on the Event Messages tab in the Output window, and continues for the next 130 seconds.
Also note that the temperature, velocity and Mach number all rise sharply shortly after the valve opens,
with the Mach number rapidly reaching one. After the initial rise, the temperature and velocity both decay
while the Mach number remains at one. The velocity drops because sonic velocity has a positive cor-
relation with temperature, so as the temperature decays, the velocity required for choked flow also
decreases. Itis good to keep in mind this correlation between temperature and sonic velocity. This rela-
tionship is important to understand when looking at systems that encounter choking.

»In the Quick Access Panel, open the Transient Jct Tab. Under Select Junctions, add J1 (Supply
Tank). Select the Graph Parameters as Tank Pressure Stagnation and Tank Temperature Stagnation
(see Figure 32). Set the units to bar and deg. C. Click the Generate button. This will show the tem-
perature and pressure in the supply tank (Figure 33).

Note: AFT xStream assumes all pipes are adiabatic (perfectly insulated). Over a 240 second run time

this assumption may not be accurate. Consider this when evaluating simulation results over
longer times.
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ﬂIransientPipe fadl Transientict Ern:ufilr:
Select Junctions: Graph These Junctions:
11 (Supply Tank) 11 (Supply Tank
12 (Valve)
>
<
<
Multi-Scenario... * || Current Only
Time Units: | seconds -
Time Frame: | (@) Al Times () User Specified
Select Parameter 4 Add ~ X Remove 4 =
Parameter Units DA
vw| Tank Pressure Stagnation ~| bar - O
» vl Tank TemperatureStagnation -| deg.C -~ O

Figure 32: Graph Parameters window for the Transient Junction graph

Graph Results o x

E I e = m Q| & £ What Would You Like to Do?

Pressure Stagnation - J1 (Supply Tank)
'%" 40
=)
o 30
o
et
Lg 20
w0
L
o 10
0
200
) Temperature Stagnation - J1 (Supply Tank)
=
L 10
(w)]
]
n 0
a
£
(i
'—
-100
0 50 100 150 200 250 300
Time (seconds)
B x + 5~

Figure 33: The Transient Junction graph shows how variables within a junction change over time. The tem-
perature and pressure of Tank J1 over time are plotted.

This junction graph could be used to determine when certain conditions within the tank were met. For
instance, suppose there was a need to know when the tank pressure dropped below 25 bar. The junction
graph would indicate the tank pressure would reach such a point around 60 seconds after beginning of
the tank blowdown. Also note that the rate of decrease in the tank pressure decays at later time points as
the pressure gradient driving flow out of the tank becomes smaller as time progresses.
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Lastly, we will animate the profile of the Blowdown Tank system to show the wave caused by opening the
valve. In the Quick Access Panel, open the Profile tab. Under Plot Single Path, select Pipe 1 and Pipe 2.
After ensuring your length is meters, select the option to Animate Using Output and ensure the Animation
Time Units are set to seconds. Add Parameters until you have 4, then set them to Pressure Static, Tem-
perature Static, Velocity, and Density Static. Set the units to bar, Deg. C, meters/sec, and kg/m3, respect-

ively (see Figure 34).

»Click the Generate button. This will show an animated profile of the pipe system over the specified

time frame (see Figure 35).

Transient Pipe

Transient Jct

Pipes: Plot Single Path

Al 1 Pipe
2 Pipe

Mone

Invert

Workspace

Spedial...

Multi-scenario... - || Current Only
Length Units: | meters

Animate Using:

Animation Time Units:

Select Parameter
Parameter
v| Pressure Static
v| Temperature Static
vl Velocity

b w| Density Static

O MNone @ Output

seconds

Profile

4k Add ~ X Remove

Units
~ | bar
- | deg.C
~ | meters/sec
~ | kg/m3

Mx

Mn

ooogg =
oooog ¥ .

Figure 34: Profile Graph Parameters window
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Figure 35: The Profile Graph show the Maximum and Minimum values of all parameters shown in the Graph
over the specified time Frame. It can also be set to animate the values so that the behavior within the system
as a whole can be observed. The blue line correlates to minimum values, the bright red line shows maximum

value, and the dark red line shows the value at the current timestep.

Take note of the pressure wave that is created at the valve just after animation is started. This wave
travels to the Assigned Pressure junction before reflecting back towards the valve. The amount of time it
takes this wave to travel to the reflection point and back is called the communication time. It should be
noted when creating your transient that any event that occurs over a shorter length of time than the com-
munication time of the system is considered to happen instantaneously.

C. View the Visual Report

The Visual Report allows you to show text output alongside the model schematic. This is useful to quickly
show pertinent information in relation to location in the model. The Visual Report can also animate the
transient pipe results in a color animation overlaid on the model.

»Change to the Visual Report window by choosing it from the Window menu, clicking the Visual
Report tab or by pressing Ctrl+l. The Visual Report window allows you to integrate your text results with
the graphic layout of your pipe network. The Visual Report Control window should open automatically
when accessing the Visual Report window for the first time. The Visual Report Control window can also
be opened from the Visual Report Toolbar or the Tools menu. Note that the parameters present in Visual
Report Control are determined by the parameters selected in Output Control.

»Select "Max Temperature Static” and "Min Temperature Static" in the Pipe Transient Output area
of the Visual Report Window as shown in Figure 36. Click the Show button. This will generate the Visual
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Report window graphic seen in Figure 37.

Itis common for the text in the Visual Report window to overlap when first generated. You can change
this by selecting smaller fonts or by dragging the text to a new area to increase clarity. You can also use
the Visual Report Control window to display units in a legend to increase the clarity of the display. These
adjustments have already been done in Figure 37. This window can be printed or copied to the clipboard
for import into other Windows graphics programs, saved to a file, or printed to an Adobe PDF file.

Visual Repert Contrel - Transient Output Mode

Display Mode
O mput () Steady Output (®) Transient Output () Animate ‘ [] Automatically Refresh Visual Report After Run

Display Parameters | General Display | Show Selected Pipesilunctions | Color Map |

1= [®] Pipe Transient Output
Max Temperature Static
Min Temperature Static
Max Pressure Static
Min Pressure Static
Max Mass Flowrate
Min Mass Flowrate
Max Velocity
Min Velocity

minlnlnlnlnlih

Cutput Window Table Header:  Static Temperature
Visual Report Abbreviation: T
Description: Transient static temperature at specified pipe station

The features on this tab folder are specified for the transient output mode anly.

Librany

|n Save Options... | |!, User Defautt | |l‘“ Reset Locations ‘ |® Show |

[a" Load Options... | |; Set as Default | |® Help ‘ | Cancel |

Same As Parent -

Figure 36: The Visual Report Control window selects content for the Visual Report window
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Visual Report o x
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Figure 37: The Visual Report integrates results with model layout

D. Examine the Effect of Heat Transfer

By default AFT xStream models all pipes as adiabatic at the internal surface, meaning no heat is trans-
ferred from the fluid to the pipe walls or surroundings. Modeling the pipes as adiabatic is reasonable
when the pipes are well insulated and the temperature difference between the fluid and the atmosphere
is relatively low. However, for cases such as the tank blowdown modeled in this example heat transfer
from the fluid to the pipe walls and environment has a large impact on results.

To see the impact of convective heat transfer on the results create a child scenario named “Convective
Heat Transfer.”

In the “Convective Heat Transfer” scenario update pipes P1 and P2. Open the Pipe Properties window
for each pipe and enter the following on the Heat Transfer tab (Fig):

1. Heat Transfer Model = Convective Heat Transfer
2. External Convection Coefficient Correlation = Free-Horizontal (Churchill-Chu)
3. Ambient Temperature =21.1 deg. C

After updating each of the pipes open the Analysis Setup window and go to the Pipe Sectioning and Out-
put panel. Change the Estimated Maximum Pipe Fluid Temperature During Transient to 175 deg. C and
click OK to accept the changes.

»Run the model and go to the Output window.

In the Transient Max/Min tab shown in Figure 38 it can be seen that the maximum temperature in pipe P2
is only 112 deg. C as opposed to 919 deg. C which was calculated with adiabatic heat transfer.

- 38 -



Tank Blowdown Example

Go to the Graph results window and recreate the pipe P2 outlet graph from Figure 31 as is shown below

in Figure 39.
A  Pipes  Auwial Points  Transient Output | Transient Max/Min | Hest Transfer
Max. Static Max. Static Max. Static Min. Static Min. Static Min. Static | Max. Static Max. Static Max. Static
Pipe Temperature | Temperature | Temperature | Temperature | Temperature | Temperature | Pressure Pressure Pressure
(deg. C) Time (seconds) Station (deg. C) Time (seconds) Station (bar) Time (seconds) Station

1 150.0 0.000 0 -25.83 2400 0 45.00 0.000 1
2 1115 16.34 0 -18.36 0.02114 0 38.51 2988 0
< >

Figure 38: Transient Max/Min temperature output with convective heat transfer modelled
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Figure 39: Temperature, velocity, and Mach number for the discharge of Pipe P2 with convective heat trans-
fer

E. Examine the Effect of Sectioning

In AFT xStream, sectioning plays an important role in model accuracy. Due to how the MOC operates,
accuracy increases with the number of sections you have in the model. To illustrate this, the model was
re-run with a Minimum Number of Sections Per Pipe of 6. Comparing Figure 33 to Figure 42, values such
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as the tank temperature and pressure for Tank J1 remain similar with the increase in the number of sec-
tions. However, values such as the maximum temperature reached in Pipe 2 (Figure 25 and Figure 40),
changed substantially. This value increased from 919 deg. C to 1203 deg. C. This change in the max-
imum temperature indicates that the difference in sectioning has significant implications if your interest is
in the conditions in the blowdown pipe. It should be noted that changing the Minimum Number of Sec-
tions Per Pipe from one to six caused the computation time of the model to increase from 5-6 minutes to
3.5 hours. Therefore, it is of critical importance to balance accuracy and computation time when using
AFT xStream. This idea is discussed in more detail here.

Due to the long run time, it was not sensible to ask you to run the 6 section scenario as a part of this
example. If you are interested, you may want to run this scenario overnight.

2  Pipes AxialPoints  Transient Output | Transient Max/Min | Heat Transfer

Mazx. Static Max. Static Mazx. Static Min. Static Min. Static Min. Static | Max. Static Max. Static Max. Static
Fipe | Temperature | Temperature | Temperature | Tempersture | Temperature | Tempersture | Pressure Pressure Pressure
(deg Time (seconds) Station (deg. C) Time (seconds) Station (bar) Time (seconds) Station
1 180.0 3.386E-03 0 -3073 240.0 0 45.00 1.893E-03 0
2 1,202.8 2974 367 -3766 2400 450 40.52 2614 0

Figure 40: Transient Min/Max window for modified sectioning
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Figure 41: Temperature, velocity, and Mach number for the discharge of Pipe P2 with 6 sections minimum per
pipe
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Figure 42: Temperature and pressure stagnation for Tank J1 with 6 sections minimum per pipe
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Figure 43: Profile Graph for Tank Blowdown system with 6 Sections Minimum Per Pipe where the blue line
represents the minimum value, the bright red line represents the maximum value and the dark red line rep-
resents the value at the current time step

Conclusion

You have now used AFT xStream's five Primary Windows to build and analyze a simple gas transient

model.
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Summary

A compressor feeding natural gas to combustion baskets in a Turbine Fuel System has one of its 3 con-
trol valves close instantaneously. The effect of this transient event on the temperature, pressure, and
velocity of the system is observed.

Topics covered

This example will cover the following topics:

* Modeling a valve closure as a transient event

* Modeling a heat exchanger

* Using the Scenario Manager in AFT xStream

* Indicating the importance of the Estimated Maximum Temperature During Transient
* Creating animated profile graphs

Required knowledge

This example assumes the user has already worked through the Beginner: Tank Blowdown example, or
has a level of knowledge consistent with that topic.

Model file

The file listed below contains a completed version of this example and can be located in the Examples
folder as part of the AFT xStream installation. This file can also be downloaded from the AFT xStream
help site from the Gas Turbine Fuel Example page:

* Metric - Gas Turbine Fuel System.xtr

Step 1. Start AFT xStream

Open AFT xStream. Click "Start Building Model".
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Step 2. Build the model

A. Place the pipes and junctions

The first step is to define the pipes and junctions. In the Workspace window, assemble the model as
shown in Figure 1.

rkspace o x
- - @I e-a B B ¢
~
= £
O O 1 J2 J5 JE
F:'D Matural Gas Diffusion Combustion
Compressor Heater J3 J4 Gas FCV Basket #1
Pl P2 P3 P4 P5
o> q = 9 ©
=5
P& 2 n
? b= Premix Gas Combustion
- FCVa1 Basket #2
= g7 F7 PB
il i 6
P a
P i nz
Fremix Gas Combustion
o FovE Basket 23
J10 P10 P11
e > 6
L
w
< >
Base Scenario b | G 100% | O | =411 | @312

Figure 1: Layout of gas turbine fuel system

B. Enter the pipe and junction data

The system is in place but now the input data for the pipes and junctions needs to be entered. Enter the
following data in each Pipe and Junction Properties window.

All Pipes are Stainless Steel - ANSI, Schedule 10S, and have standard roughness. The rest of the pipe
information is as follows:

Pipe # Size (inches) Length (meters)
1 8 23
2 8 7.5
3 8 1.5
4 5 1.5
5 5 1.5
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Pipe # Size (inches) Length (meters)
6 8 1.5
7 5 1.5
8 5 1.5
9 8 1.5
10 5 1.5
11 5 1.5

Because several of the pipes are the same, you can use the Global Pipe Editing tool to speed up the pro-
cess of entering the data. The Global Pipe Editing tool allows you to apply changes to multiple pipes at
the same time. Select Global Pipe Edit either from the Edit Menu, or by selecting the "Global Edit" drop-
down on the toolbar and selecting the "Global Pipe Edit" option. This will open the Global Pipe Edit win-
dow. Select pipes P4, P5, P7, P8, P10, and P11 from the list of pipes as shown in Figure 2.

Global Pipe Edit

Choose Data From: B o
@ Guide >>
(® Pipe Template Select Pipe Data.. Click "Select Pipe Data...'to Specify Parameters
() Existing Pipe
Al None || Invert
Pipe List Workspace || Special...
1 Pipe
12 Pipe
3 Pipe
B 4 Pipe
A 5 Fipe
& Pipe
B 7 Fipe
8 Pipe
]9 Pipe
k4 10 Fipe
kA 11 Fipe

B|E Selected: 6of 11

= ! Cancel 2 Help

Figure 2: Global Pipe Edit window

After selecting the pipes, click the "Select Pipe Data" button. This will open a template Pipe Properties
window for entering the data to be applied to all of the selected pipes. Fill out the data for the selected
pipes. When you have entered all of the data for the pipes, close the Pipe Properties window by selecting
OK. The Global Pipe Edit window will now display a list of all of the parameters that may be applied to the
selected pipes. The parameters are categorized as they are displayed on the tabs in the Pipe Properties
window. For this example, you want all of the parameters for all of the selected pipes to be updated to the
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specified values. This can be accomplished by selecting the "All" button above the list of parameters. The
Global Pipe Edit window should now appear as shown in Figure 3.

Global Pipe Edit
Choose Data From: @ Guide >>
® Pipe Template Select Pipe Data... Click 'Select Pipe Data..."to Specify Parameters
() Existing Pipe
Al MNome | Invert
Pipe List Workspace || Special... Parameters to Change (Select in List): Al | None || Invert
11 Pipe -1[v] General Data 2
= 2 P?pe Name Fipe
3 Pipe -
z 4 Fipe = Pipe Model
5 Fipe Material Stainless Steel - ANSI
[]6 Fipe heminal Size Sinch
% ; E:E: Type schedule 105
mE) Pipe Length 1.5 meters
[ 10 Fipe Scaling (ID Reduction) Mone
(A 11 Pipe Friction Data Set z
Foughness
= Fittings & Losses
Replace Wwith |~ |Fittings & Losses
= Heat Transfer
Heat Transfer Model Adizbatic at Internal Surface
Insulation Type Mone
-I[v] Design Aleris
Replace With |~ | Design Alerts (nane)
—I[1 Ointinnzl v
S| B selected: 6of 11 EE B
=3 Apply Selections E3 Cancel B Help

Figure 3: Global Pipe Edit window with all pipe parameters selected for updating

Apply the changes to the selected pipes by clicking the "Apply Selections” button. AFT xStream will notify
you that the changes have been completed. Select OK. At this point, all of the changes have been
applied but not saved. If you wish to cancel all of the changes you just implemented, you may do so by
clicking Cancel on the Global Pipe Edit window. Save the applied changes by clicking OK.

Notes: The "Guide >>" button in the Global Edit windows may be used as a reminder of the required
steps for the global edit process if needed.

1. Assigned Flow J1
a. Name =PD Compressor
b. Elevation =0 meters
c. Mass Flow Rate =41,400 kg/hr

Note: Be advised that the unit for mass flow is not the default as it is kg/hr as opposed to
kg/s.

d. Temperature =21deg.C
2. Heat Exchanger J2
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a. Name = Natural Gas Heater
b. Elevation =0 meters
c. K=6.6
d. Steady Heat Rate =1,035 kW
3. Valve J3
a. Elevation =0 meters
b. K,=8,650
c. X=03
4. Valve J5
a. Name = Diffusion Gas FCV
b. Elevation =0 meters
c. K,=80
d. X;=07
5. Valve J8
a. Name =Premix Gas FCV #1
b. Elevation = 0 meters
c. K,=170
d. X=07
6. Valve J11
a. Name =Premix Gas FCV #2
b. Elevation =0 meters
c. K,=170
d. X=07
e. Click on the Transient Tab and enter the following data
Time (seconds) K, X
0 170 0.7
0.01 0 0.7
2 0 0.7

7. Assigned Pressures J6, J9, J12

®© 20 T Qo

f.

J6 Name = Combustion Basket #1
J9 Name = Combustion Basket #2
J12 Name = Combustion Basket #3
Elevation = 0 meters

Stagnation Pressure = 15.7 bar
Temperature = 60 deg. C.

8. Junctions J4, J7, J10

a.

Elevation = 0 meters
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C. Check if the pipe and junction data is complete

=

»O0Open the List Undefined Objects window from the View Menu or the Workspace Toolbar = to
verify if all pipes and junctions are specified. If not, the incomplete pipes or junctions will be listed. If
undefined objects are present, go back to the incomplete pipes or junctions and enter the missing data.

Step 3. Specify Analysis Setup

A. Specify the Fluid panel

»Open the Analysis Setup window by clicking Analysis Setup on the Main Toolbar. Under the
"AFT Standard" fluid option, select "Methane" from the list and click the "Add to Model" button. Click OK.

Note: Methane is used to model natural gas in order to minimize the run time. If you need to model a
real natural gas mixture, then instead of using the AFT Standard fluid library, it would be better
to use the NIST REFPRORP library or the optional Chempak add-on.

B. Specify the Pipe Sectioning and Output panel

»O0pen the Pipe Sectioning and Output panel. Set the Minimum Number of Sections Per Pipe to 8 sec-
tions and the Estimated Maximum Pipe Temperature During Transient to 60 deg. C.

Note: If following along in the completed model file, the Estimated Maximum Pipe Temperature Dur-
ing Transient will have a different value. This will be discussed in Steps 8 and 9.

Anlysis Setup x
|19 Modules ~ | Pipe Sectioning and Oulput
@®  Fluid Properties ~ Viimum Number of Sections Per Pipe: This value is related to aceuracy and muntime. Sez the help file for details.
&I  Pipes and Junciions ~ Estimated Maximum Pipe Fluid Temperature During Transient: deg.C -
O Feriinems Pipe Stations To Include In Transient Outpu File
§l#9  Pipe Sectioning and Ouiput ~ O Inlet Ot Oniy
© “Pipe Sectioning and Output @A
& Transient Control ~ Sectioning Surmary
- . Shortest Fipe: 1.50 meters Estimated Total Steps: —
 Smrem e Keal Section: 019 meters Total Stations: 235
O T S i Estimated Max. Soric Velocty: 456 58 meters /sec Estimsted Total Pipe Compitations: —
Estimated Time Step: 2.008295-04 seconds
0 Forces ~ —
[[¥1 Sectioning Detaits |
29 S =
[ Advanced Sectioning Centrols |
9 Environmental Properfies
=  Miscellaneous -
xStream Defa:
Collapse Al Groups = Same As Parert D e ok 3 Cancel

Figure 4: Sectioning panel for Turbine Fuel System
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C. Specify the Simulation Mode/Duration panel

»Open the Simulation Mode/Duration panel from the Transient Control group. Enter the Stop Time
as 2 seconds. Verify the Time Simulation is set to Transient. Click the OK button.

Step 4. Create scenarios to model different sectioning setups

A. Create scenarios

In this model, the following three types of Sectioning cases for the system are to be evaluated:

1. 8 Sections Minimum per Pipe
2. 4 Sections Minimum per Pipe
3. 2 Sections Minimum per Pipe

To evaluate the three cases, we will utilize the Scenario Manager to create three scenarios for the three
cases.

Open the Scenario Manager on the Quick Access Panel. Create a child scenario by either right-clicking
on the Base Scenario and then selecting Create Child, or by first selecting the Base Scenario on the

Scenario Manager on the Quick Access Panel and then selecting the Create Child icon % Enterthe
name "8 Sections Minimum Per Pipe" in the Create Child Scenario window, and select the OK button.
The new "8 Sections Minimum Per Pipe" scenario should now appear in the Scenario Manager on the
Quick Access Panel below the Base Scenario. Select the Base Scenario. Create another child and call it
"4 Sections Minimum Per Pipe". Finally, create one more child and call it "2 Sections Minimum Per Pipe".
The Child Scenarios should now be displayed as shown in Figure 5.
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Y | am | B H v | B~
= @ Base Scenaro

----- L4 8 Sections Minimum Per Pipe

----- # 4 Sections Minimum Per Pipe

L. @ 2 Sections Minimum Per Pipe

MNotes

=m Scenario | [EZ| Properties

_=_|, Cherview Map .—| Add-on Modules Q

Figure 5: The Scenario Manager on the Quick Access Panel displays the scenario tree which allows you to
create scenarios and keep them organized within the same model file

B. Set up scenarios

Since the "8 Sections Minimum Per Pipe" scenario has the same setup as the Base Scenario, we do not
need to modify it. Select the "4 Sections Minimum Per Pipe" scenario by double-clicking the name in the
Scenario Manager.

»O0pen the Analysis Setup window from the Main Toolbar. Click on the Pipe Sectioning and Output
panel and change the Minimum Number of Sections Per Pipe to 4 then click OK.
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»Open the Child Scenario "2 Sections Minimum per Pipe". Open the Analysis Setup window from
the Main Toolbar. Open the Pipe Sectioning and Output panel and change the Minimum Number of Sec-
tions Per Pipe to 2 then click OK.

Step 5. Run the first scenario

»Double-click the "2 Sections Minimum Per Pipe" scenario in the Scenario Manager. Select "Run
Model" on the toolbar. AFT xStream will prompt you to save, then will open the Solution Progress win-
dow. This model is estimated to run in approximately one minute, but the run time is dependent on the
speed of your computer.

Step 6. Review the results

»Click the Output button. This will take you to the Output window, which will display any warnings if
they exist. There should be a warning indicating that the maximum transient pipe temperature was higher
than the estimate as well as a caution that the maximum transient pipe mach number was significantly
lower than the estimate (see Figure 6). The Estimated Maximum Pipe Temperature During Transient is
critical to the calculation of transient conditions due to its necessity in the Method of Characteristics. A
review on how the MOC handles sectioning and tabulation can be found here.

The Estimated Maximum Pipe Temperature During Transient is used to calculate the sonic velocity of the
fluid, which is then used to create the upper boundary of the characteristic grid. If the maximum tem-
perature during the transient exceeds the specified Estimated Maximum Pipe Temperature During Tran-
sient and the flow is sonic, the Method of Characteristics may have to extrapolate data, which can lead to
instability and will stop the transient solver. In this model, sonic velocity was not reached when the tem-
perature was higher than the estimated maximum. However, to ensure that this model can handle sonic
flow, we will re-run the model with a higher Estimated Maximum Pipe Temperature During Transient.

The Maximum Transient Pipe Mach Number error indicates that error could be introduced through hav-
ing a Mach Number substantially lower than the Maximum Transient Pipe Mach Number used for the cal-
culation (in this case, the xStream default value of one). This caution will be ignored in this example for
simplicity.

2 | Genersl | Warnings | DesignAlerts | Applied Standards | Valve Summary | Heat Exchanger Summary

Messages
For an explanation of Warnings, click an itom in his listand press F1 or search for Wamings' in the Help system.
- WARNING

The maximum transient pipe temperature (75,20 deg. C) was higher than the estimate (80.00deg. C). The estimated maximum pipe temperature should be set marginally above the maximum.

Figure 6: The maximum transient pipe temperature exceeds estimated maximum temperature warning indic-
ates that the model is at risk of instability if changes are made
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Step 7. Adjust the Pipe Sectioning panel

»Double-click "Base Scenario" in the Scenario Manager. Open the Analysis Setup window from the
Main Toolbar and select the Pipe Sectioning and Output panel. Change the Estimated Maximum Pipe
Temperature During Transient to 80 deg. C. Click OK.

Note: It is essential that this change is made in the Base Scenario so all scenarios are updated.

Step 8. Re-run the model and review results

A. Review Output window

»Double-click the "8 Sections Minimum Per Pipe" scenario. Select "Run Model" from the Analysis
menu, then proceed to the Output window. There should be a caution indicating that the maximum tran-
sient pipe mach number was significantly lower than the estimate. Disregard this error as discussed pre-
viously. Select the Transient Max/Min tab (Figure 7). Here we can see that the maximum temperature in
the inlet lines (P5, P8, & P11) to the combustion baskets is 72.7 deg. C and occurs in the inlet line to com-
bustion basket 1.

A Pipes Axial Points = Transient Output | TransientMax/Min | Heat Transfer

scity | Min. Velocity | Min. Velocity | Min. Velocity | Max. Static Max. Static Max. Static Min. Static Min. Static Min. Static

Fipe | Time (seconds) Station Temperature | Temperature | Temperature | Tempersture | Temperature | Temperature
(meters/zec) (deg. C) Time (seconds) Station (deg. C) Time (seconds) Station

1 123 18934 0.04303 123 2695 0.8106 123 2094 0.23%0 2
2 40 20478 0.02523 40 7167 0.04303 0 5854 0.000 1
3 8 20328 0.02171 8 7410 0.3676 0 5854 0.000 4
4 0 14.652 0.02653 ] 73.88 04202 0 5313 2.152E-03 ]
5 ] 16623 5 477E-03 3 04306 0 5846 002835 4
6 2 11.021 0.02015 2 739 04202 0 59.03 0.000 2
7 8 33.041 INTE03 ] 73.00 0.5078 2 58.94 0.000 2
8 8 35278 7.825E-04 ] 7199 0.5237 0 5810 0.02504 5
3 8 -5.025 0.01721 ] 73.50 0.5013 0 5314 1.565E-03 ]
10 ] -8784 0.01389 0 £3.74 2.000 0 5854 0.000 2
11 2 -16.765 0.01330 2 70.02 0.01643 0 56.37 0.01056 3
£ >

Figure 7: Transient Max/Min tab in the Output window

B. Graph the results

Go to the Graph Results window by clicking on the Graph Results tab or pressing Ctrl+G on the key-
board.

Create a graph that shows the temperature over time at the entrance to Combustion Basket #1 using the
following steps:

1. From the Graph Control tab on the Quick Access Panel, select the Transient Pipe tab as shown in
Figure 8
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2. Select Pipe P5 and add the outlet station
Verify that the time units are set to seconds

4. Inthe Parameters definition area, select "Temperature Static" and specify "deg. C" in the drop-
down box under "Units"

5. Click the Generate button

w

The results (see Figure 9) show a maximum temperature of 72.3 deg. C at the entrance to combustion
basket #1. Note this temperature is lower than the temperature shown on the Transient Max/min tab
because this graph is showing the outlet of pipe P5,while the maximum temperature in pipe P5 occurs at
the inlet of the pipe. The maximum temperature for the outlet of P5 occurs at about 0.6 seconds before
returning to the previous steady state temperature of 60 deg. C after the flow has normalized.

To easily recreate this graph in the other scenarios or in the future, it can be added into the Graph List

Manager on the Quick Access Panel. After generating the graph, click the "Add Graph to List" icon * on
the Graph Results Toolbar (or simply right-click the graph itself and choose "Add Graph to List"). Give the
graph a name, such as "Combustion Basket #1 Temperature vs Time", then click OK. The graph will be
added to the currently selected folder in the Graph List Manager. Note that graphs added to the Graph
List Manager are not permanently saved until the model is saved again. Also be aware that only the
graph templates are saved as opposed to the graph data.
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Select Pipe Stations: Graph These Pipes//Stations:
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Figure 8: Graph Parameters for Combustion Basket #1 Inlet Pipe
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Graph Results o x

= | By & 1 |z Dmm Q% & e 1% What Would You Like to Do?

Temperature Static vs. Time

80
40

20

Temperature Static (deg. C)

Static Temperature - P5 , Sta. 8 (Outlet)

a 0.5 1 1.5 2
Time (seconds)

H x> = 5 -

Base Scenario/8 Sections Minimum per Pipe

Figure 9: Combustion Basket #1 Temperature vs Time Graph

C. Animate the results

We will create a graph that models the temperature, pressure, and velocity along the flow path between
the positive displacement compressor and Combustion Basket #1. To do this:

1. Create a new graph tab by clicking the "New Tab" button

2. Select the Profile tab under the Graph Control tab in the Quick Access Panel. Alternatively, you
can access the Select Graph Parameters window by clicking on the "Select Graph Parameters™
icon located at the top left of the Graph Results window.

Select pipes 1,2, 3,4,and 5

Select the option to Animate Using Output.

Ensure that the animation time used is seconds.

Select Temperature Static as a parameter.

Add Pressure Static and Velocity Parameters to the Parameters Window.
Click Generate.

© N ok

To view the animated profile

follow this link: https://bit.ly/3NIQoWC

You should generate a graph that looks like the one shown in Figure 10. Playing the animation reveals
that the highest temperature in the system is observed at the J2 heat exchanger. It should also be noted
that the rise to this maximum temperature occurs when the pressure wave from the valve closing passes
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through this junction. This heightened temperature is notimmediately seen by the combustion baskets
downstream, however, as the gas velocity throughout the system drops immediately following the valve
closure. Instead, the heightened temperature moves slowly downstream until the gas wave is reflected at
the positive displacement compressor and passes through the heat exchanger going the opposite dir-
ection. This causes the local gas velocity to rise and causes the temperature wave to move downstream
towards the combustion baskets more quickly. This wave eventually reaches combustion basket #1 at
T= 0.5 seconds, at which point the inlet to the combustion basket reaches its maximum temperature.

Click the "Add Graph to List" icon and give it a name such as "Combustion Basket #1 Profile". Click OK to

add the Graph to the Graph List.

Note:Figure 10 has had the axes titles modified to increase clarity.

B Transient Pipe B Transient Jet B Frofile
Pipes: Plot Single Path -
Al 1 Pipe ~
2 Pipe
Mone 3 Pipe
Invert 4 Pipe
s 5 Pipe
Workspace || []6 Pipe
) az Pipe
Special .. Oe Pipe v
Multiscenario... || Cument Only
Length Units: | meters -
Animate Using: |(O None (@ Output
Animation Time Units: | seconds <
Select Parameter df Add -~ X Remove <
Parameter Units Max | Mn | SS | DA
1 |w| Temperature Static ~| deg. C - OO
v Pressure Static = | bar - D D
| Velocity ~ | meters/sec  ~ OO

Figure 10: Graph Parameters for Combustion Basket #1 Profile

-55 -




Gas Turbine Fuel System Example

D Play @Recod M Sicp Il Pause  Time: 0.0000
e E e e = B ]| &

0] @ # | Speed: ® | Default

& What Would You Like to Do?

N

Static Temperature

T Stat. (deg. C)

Max Static Temperature
Min Static Temperature

]
. L
o
=
o 10
I :
A Static Pressure
e s Max Static Pressure
Min Static Pressure

0

40
3 30 I
i
<]
@ 20
E Velocity L—l—
= 10 Max Velocity
= Min Velocity

0

o 10 20 30 40
Length (meters) Time (seconds): 0.0
B x = ¥ -

Figure 11: Combustion Basket #1 Profile

Note: You can make similar graphs for combustion basket #2. To do so, change the pipe used in the
temperature vs time graph to pipe 8, and change the pipes in the animated profile graph to 1, 2,
3, 6,7, and 8. This would generate similar graphs to the ones seen in and Figure 10.

Step 9. Run the other scenarios and graph the results

Using the Scenario Manager, load the other two scenarios and run them.

Create the same graphs you created for Step 10 for each of the scenarios by double-clicking on the
graph names in the Graph List Manager. This will reveal that the general behavior of the graph is the
same for all 3 scenarios, but that the maximum temperature rises as the section count is increased.

The numerical maximum temperature can be found in the Output window of each scenario and is sum-
marized in Table 1. For these cases the maximum temperatures differ by 2.5 degrees.

Table 1: Summary of maximum Static Temperature for the three cases

Case Max Transient Temperature (deg C)
8 Sections 7.7
4 Sections 76.0
2 Sections 75.2
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Conclusion

Use of transient conditions within a valve junction allowed us to model the effects of an unexpected valve
closure in a system. While this example was focused on temperature, it also showed that values such as
pressure and velocity can be tracked by AFT xStream.

Additionally, this example identifies the Estimated Maximum Temperature During Transient as a critical
variable in the tabulation of the transient results. This value sets the boundary for the characteristic grid
the Method of Characteristics uses. If sonic choking occurs at a temperature higher than the estimated
maximum, the model may not converge. As such, this value should be conservatively high on early runs
of a model and then refined once the temperature that the transient approaches is known.
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Summary

This example evaluates two turbines in a high pressure steam system that are simultaneously valved off
as a bypass line valve is opened. The focus will be the transient behavior in the bypass line in response
to simultaneous transient events. Whether or not condensation occurs will also be evaluated through the
use of different Fluid Property Models.

Topics covered

* Using the isometric grid to create a model
* Creating systems with multiple transients
* Evaluating the selection of a fluid property model

Required knowledge

This example assumes the user has already worked through the Beginner: Tank Blowdown example, or
has a level of knowledge consistent with that topic.

Model file

The file listed below contains a completed version of this example and can be located in the Examples
folder as part of the AFT xStream installation. This file can also be downloaded from the AFT xStream
help site from the High Pressure Steam - Fluid Property Models Example page:

* Metric - High Pressure Steam - Fluid Property Models.xtr

Step 1. Start AFT xStream

Open AFT xStream. Click "Start Building Model".

To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT xStream settings, unless you are specifically instructed to do otherwise.
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Step 2. Build the model

A. Place the pipes and junctions

The next step is to define the pipes and junctions.

Isometric Drawing Mode

The previous example models were drawn using the default Pipe Drawing Mode, 2D Freeform.

AFT xStream has two additional available drawing modes, 2D Orthogonal and Isometric. In this model,
the isometric mode is used to visually interpret pipe layout and provide a better understanding of the sys-
tem when analyzing calculated forces.

oD~

6.

From the Arrange menu, select the option to Show Grid
Open the Arrange menu again, go to Pipe Drawing Mode, and select Isometric
Place the junctions as shown in Figure 1

Click the Pipe Drawing Tool and draw the pipes in the model as shown. When drawing segmented
pipes such as P5, a red dashed preview line will show how the pipe will be drawn on the isometric
grid. As you are drawing a pipe, you can change the preview line by clicking any arrow key on your
keyboard or scrolling the scroll wheel on your mouse.

Use the Rotate Icons buttons on the Workspace Toolbar, or right-click on the junction and select
the Auto-rotate option to automatically align the junction with the connected pipes. Alternatively,
Customize Icon can be selected from the right-click menu to manually choose an icon/orientation.

The grid can be shown or turned off in the Arrange menu, as shown in Figure 2

Note: You can hold the "Alt" key while adjusting a pipe by the endpoint to add an additional segment.

This can be used with the arrow key or mouse scroll wheel to change between different preview
line options.
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Figure 1: The isometric layout with the grid shown
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Figure 2: The isometric layout with the grid turned off

B. Enter the pipe and junction data

The system is in place but now the input data for the pipes and junctions needs to be entered. Double-
click each pipe or junction and enter the following data in the Pipe or Junction Properties window.

All pipe materials are User Specified in this model (see Figure 3). Use the Absolute Roughness of Steel
(0.004572 cm) as the Friction Model, along with the following data:
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Note: The pipes below are user defined as they utilize non-standard pipe sizes.

Pipe # Inner Diameter (cm) | Length (meters)
1 34 30.5
2 30.5 20
3 30.5 15
4 30.5 4.5
5 30.5 4.5
6 15.5 2
7 10 2
8 15.5 3
9 15.5 1.5
10 15.5 6
11 49 6
12 49 1.5

Pipe Properties

Number:

Upstream Junction:

Name: |Pipe

Downstream Junction:

Copy Data From Pipe...

Fipe Model | Fittings & Losses | Heat Transfer | DesignAlerts | Optional | Motes Status

Size

Pipe Material: | (User Specified)

Inner Diameter:

[ Jlem

[ ID Reduction {Sealing):

Friction Model
Data Set

(®) User Specfied

Length

v meters

Absolute Roughness

0.004572 cm

B cancel
Jump.

2 Help

Load Default

Figure 3: User Specified Pipe Properties window
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Assigned Pressure J1

a. Name = High Pressure Steam Inlet
b. Elevation =0 meters
c. Static Pressure =170 bar
d. Temperature =570deg.C
Area Change J2
a. Type = Conical Transition
b. Angle =45 degrees
Branch J3,J4,J7
a. Elevation =0 meters

Assigned Flowrate J5,J6

a. J5Name =Turbine 1
b. J6 Name = Turbine 2
c. Elevation =0 meters
d. Mass Flowrate = 228600 kg/hr
Note: Ensure that you change the unit in the Mass Flowrate from kg/s to kg/hr, as kg/hr
is not the default unit.
e. Temperature =570 deg. C
Dead End J8
a. Elevation =0 meters
Bend J9
a. Elevation =0 meters
b. Type = Standard Elbow (knee, threaded)

Bend J10, J12

a. Elevation =1.5 meters
b. Type = Standard Elbow (knee, threaded)
Valve J11
a. K,=2600
b. X{=0.7
c. Elevation=1.5meters
d. Inthe optional tab, set the special condition to closed
e. Click on the Transient Tab and enter the following data

Time (seconds) K, X
0 0 0.7
2 2600 0.7
5 2600 0.7
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9. Assigned Pressure J13

a. Name = Steam Bypass Outlet

b. Elevation = 0 meters

c. Static Pressure = 30 bar

d. Static Temperature = 350 deg. C

C. Check if the pipes and junctions are specified

»Click the List Undefined Objects button to see if the model is fully defined. If it is not, the undefined
pipes and junctions window will show a list of incomplete items. If undefined objects are present, go back
to the incomplete pipes or junctions and enter the missing data.

Step 3. Specify Analysis Setup

A. Specify Fluid panel

»O0Open the Analysis Setup window from the Main Toolbar and open the Fluid panel. Under the "AFT
Standard" fluid option, choose "Steam" from the list and click the "Add to Model" button. Click OK.

B. Specify the Pipe Sectioning and Output panel

»Open the Pipe Sectioning and Output panel. Specify the Minimum Number of Sections Per Pipe as
1 and the Estimated Maximum Pipe Temperature During Transient to 600 deg. C.

Analysis Setup X
19  Modues | Pipe Sectioning and Output
@@  Fhud Properfies e Mirimum Number of Sections Per Pipe This value is related to accuracy and runtime. See the help file for details
£  Pipes and Juncions v Estimated Maximum Pipe Fluid Temperature During Transient: deg.C -
49 PipeSectioning and Output ~ Pipe Stations Ta Include In Transient Output File
© *Pipe Sectioning and Output O Iet/Outlet Orly
&1 Transient Control ~ ®n
Sectioning Summai
P Forces g
Shortest Pipe: 1.50 meters Estimated Total Steps: —
g AFTAmyT Steady » Ideal Section: 1.50 meters Total Stations: 63
Solution Estimated Max. Sonic Velocity: 675.16 meters/sec Estimated Total Pipe Computations: —
o Ewi e Estimated Time Step: 1.110856<-03 seconds
‘El Sectioning Details ‘
E®  Miscellancous ~
|E| Advanced Sectioning Controls ‘
xStream Default
Collapse All Groups 7 Same As Parert P Help o 0K B3 Cancel

Figure 4: Sectioning panel for High Pressure Steam System
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C. Specify the Simulation Mode/Duration panel

»O0pen the Simulation Mode/Duration panel from the Transient Control group from the Analysis
Setup window. Enter the Stop Time as 5 seconds. Click the OK button.

Step 4. Run the model

»Select "Run Model" from the Main Toolbar. The model has an estimated run time of 5 minutes, but
the run time is dependent on the speed of your PC.

Step 5. Graph the results

A. Graph the transient pressures at the turbines

»Go to the Graph Results window. The first graph we make will show the Static Pressure at the
entrance to the steam turbines.

From the Graph Control tab on the Quick Access Panel, select the Transient Pipe tab
Select the pipe P5 outlet station
Ensure that time units are set to seconds

In the Parameters definition area, select "Pressure Static" and specify "bar" in the dropdown box
under Units

5. Click Generate

Ao bNh =

This will generate the graph shown in Figure 6. The pressure variation is difficult to see using the default
y-axis scale so we will adjust the scale using the following steps:

1. Right-click the y-axis
2. Uncheck the Auto Scale box
3. Setthe Minimum to 150 bar, the Maximum to 190 bar, and Major Val to 10 (see Figure 7)

The graph should now match Figure 8. When the model contains multiple transient events, transient pipe
graphs allow the user to see the cumulative impact of the events on system pressure. Note that the first
peak contains an oscillation, which is attributable to the opening of the bypass valve.
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Figure 5: Graph Parameters for Inlet Pressure to Turbines
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Graph Results
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Figure 6: Static pressure at steam turbine 2 entrance
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Figure 7: Axis Modification Window opened by right-clicking the y-axis
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Graph Results o x
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Figure 8: Static pressure at steam turbine 2 entrance with modified y-axis

B. Create a profile of the bypass line temperature and pressure

We also will animate the profile of the bypass line temperature and pressure in order to determine
whether condensation occurs.

Click the "New Tab" button to create a new graph.

From the Graph Control tab on the Quick Access Panel, select the Profile tab (Figure 9)
Select pipes 6, 8,9, and 10

Verify the Length unit is set to meters

Next to Animate Using, verify "Output” is selected, and verify "seconds" are the selected Anim-
ation Time Units

o kb=

6. Add asecond parameter in the parameters definition area, then specify one parameter to be
"Pressure Static" and the other to be "Temperature Static"

7. Change the Pressure Static units to " bar" and the Temperature Static units to "deg. C"
8. Click the Generate button
9. Click the Play button to review the graph

Note: If you wish to adjust the speed of the transient in the profile, you can use the Speed Slider in the
upper right-hand corner of the Graph Results window to speed up or slow down the animation.

Figure 10 is useful to determine whether or not condensation occurs in the system, as well as under-
standing the cause of condensation. Condensation can occur by arise in pressure, a decrease in tem-
perature, or a combination of both. Saturation line data was added for AFT Standard fluids in AFT
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xStream 2. In this model the temperatures stay well above the saturation line at all times, showing that
the steam is not close to condensing.

It should be noted that the saturation data is limited to predicting the presence of saturation conditions as
opposed to modeling the behavior of the multi-phase mixture.
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Animate Using: | () None (8 Output
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v Temperature Static ~| deg. C - OO

Figure 9: Graph Parameters for bypass line profile
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Figure 10: Bypass line animation profile

To view the animated profile, follow this link: https://bit.ly/3GDqYre
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C. Graph the mass flow rate and pressure drop through the bypass valve

Lastly, we shall create a graph to show the mass flow rate and the pressure drop through the bypass
valve to gain insight into how the flow develops in the bypass line.

Click the "New Tab"button to add a new graph tab
From the Graph Control tab on the Quick Access Panel, select the Transient Jct tab
In the Select Junctions section, select J11 and click the ">" arrow

Add a second parameter in the Select Parameters section. Specify the parameters as "Mass Flow
Rate Inlet" and "Pressure Drop Stagnation Total".

5. Setthe units for Mass Flow Rate Inlet to "kg/hr" and Pressure Drop Stagnation Total to "bar"
6. Click Generate

Poobd=

As shown in Figure 12, the flow rate increases and the pressure drop decreases as the valve opens over
time. While the observed trends for mass flow rate and pressure drop are typical for a valve that is open-
ing, itis still worthwhile to make Transient Jct graphs when multiple transient events occur in order to fully
understand the interactions between them.

Note: Figure 12 has modified axes titles and its legend removed for clarity.

B4 Transient Fipe Transient Jct B4 Erofile

Select Junctions: Graph These Junctions:
J11 (Valve) J11 (Valve)
<
e
Multi-Scenario... = || Cument Only

4
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Time Frame: | (® Al Times () User Specified

Select Parameter dr Add ~ X Remove <
Parameter Units D&

1 v Mass FlowRate Inlet ~| kaihr - O
| Pressure Drop Stagnation To.. ~| bar = |:|

Figure 11: Bypass valve mass flow and pressure drop Parameters
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Figure 12: Bypass valve mass flow rate and pressure drop transient

Step 6. Results of Other Libraries and Discussion

A. Review the results of other libraries

In addition to the AFT Standard fluid library, the model built in this example was run using the Chempak,
NIST REFPROP, and ASME Steam libraries. Similar results to the AFT Standard Fluid run were

obtained for both the bypass valve and the turbine pressure vs time graph, so these results are not

shown below. Nevertheless, it is sensible to run your system using different fluid property models as they
have been known to impact results. The temperature profile for the bypass line showed more significant
differences, as is shown below comparing the results using NIST REFPROP to the AFT Standard fluid lib-
rary. ASME Steam and Chempak gave nearly identical results to NIST, and therefore are not shown.

Note that the minimum temperature reached at J11 is 32 degrees Celsius higher in the AFT Standard
fluid library run compared to the NIST REFPROP run.

Note: The axes of the below graphs were modified for clarity.
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Figure 13: Bypass line profile obtained using NIST REFPROP

B. Advice for preliminary runs

Obtaining final results from AFT xStream will require multiple iterations. To effectively work through those
iterations, we recommend the iterative process begins with the following steps:

Step 1: Run the steady-state model

It is recommended that the first runs are completed using a simplified version of your model in the

AFT Arrow™ Steady-State Solver with each fluid property model before considering transient conditions.
This will allow for larger issues in the model to be caught before having to commit to Transient runs,
which are more time consuming. This also can inform the types of variables that need to be considered
during refined runs (i.e. if the AFT Arrow™ steady state runs are close to the saturation temperature, con-
densation is a phenomenon that should be monitored in subsequent runs).

Step 2: Complete a transient run using an AFT Standard fluid with minimal sectioning

You should then run your simplified model in the Transient Solver using an AFT Standard fluid with min-
imal sectioning. This is not always possible, such as when mixtures are present, but this step should
always be attempted if allowable. This will allow for larger issues to be caught before committing to exten-
ded run times. Only after you are satisfied with the model should you attempt increasing the number of
sections.
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C. Selection of fluid property model for final runs

A number of factors must be taken into consideration while selecting the fluid property model for an AFT
xStream model. If there are no mixtures, and the compound is present in the AFT Standard library, itis
recommended that the AFT Standard library be the first library used. AFT Standard has the shortest run
times of the four libraries and is an excellent choice for early runs focused on troubleshooting the model.
However, if there is a need to model mixtures, and simplifying the system is not possible, initial runs
should be conducted with NIST REFPROP or Chempak.

NIST REFPROP and Chempak both have greater accuracy than AFT Standard and can represent mix-
tures. However, both have slower run times than AFT Standard. Chempak runs faster than NIST
REFPROP with comparable accuracy. However, Chempak is an optional add-on while the

NIST REFPROP library comes standard with AFT xStream.

Lastly, ASME Steam provides a well-established, trustworthy source of steam data. ASME Steam has
the longest run times of the four, and it is recommended that a high processing power computer paired
with ample time be used to run your analysis if this library is selected. If either of those elements is
unavailable, it is recommended that one of the three other libraries be used, with the added note that
NIST REFPROP is the most similar in accuracy to ASME steam. Table 1 summarizes this example's run
time with the four different fluid property models. The run times will be affected by the specifications of
your computer as well as the memory available.

Table 1 shows data for runs conducted on the computers at AFT as of publication. Additionally, Table 2
provides a library compatibility chart to assist with fluid property model selection.

It should be noted that if a tremendous amount of accuracy is needed, appropriate library selection will
not be sufficient to give a high accuracy model. The single parameter that will have the greatest effect on
accuracy is the Minimum Number of Sections per Pipe in the Sectioning panel. Ultimately, appropriate
sectioning remains the single most important factor in creating a high accuracy model and should be
weighed just as heavily as the fluid library when setting the parameters your transient gas system uses.

Table 1: Comparison of High Pressure Steam System run times

High Pressure Steam System Run Times

Fluid Property Model Run Time
AFT Standard - 1 Section 1 -2 minutes
Chempak - 1 Section 8 - 10 minutes

NIST REFPROP - 1 Section 0.9-1.4 hours

AFT Standard - 10 Sections 1.6 -2 hours

ASME Steam - 1 Section 3.9-4 hours
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Table 2: Compatibility chart for fluid property model selection for final runs

Model Requirements
Fluid Library Mixtures Complex User Spe-
Systems* cified Fluids
AFT Standard . v v
NIST v v .

REFPROP

Chempak v v .
ASME Steam - . -

* Evaluating the complexity of a system is most easily done in early runs of the model. It is suggested that
all early runs should be run with a version of AFT Standard if they can, and the run time recorded. This
run time should inform your decision on which fluid library is needed to run the more thorough runs when
high accuracy results are needed. As seen from Table 1, the run times can vary wildly between the 4 lib-
raries, so make sure you evaluate your time constraints and accuracy needs when weighing this
decision. Factors that can impact the run time include the ratio in the length of the smallest pipe to the
largest pipe, presence of mixtures, usage of Junctions containing resistance curves, and the presence of
sonic choking. See the Reducing Run Time section for more information.

Conclusions

The mass flow rate through the bypass line was modeled and the cumulative effect of multiple transient
events was observed.
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Summary

Two turbines in a high pressure steam system are simultaneously valved off, which causes the system to
experience transient forces. This example describes how to determine the imbalanced transient force
data for the piping system during the steam flow transient. It also evaluates the effect of varying the time
to close the valves on force magnitude. Lastly, this example shows how to export the force results to a
force file to use in piping stress software.

Topics covered

* Calculating the forces associated with a transient event

* Using the Scenario Comparison Tool to compare scenarios
o Exporting force sets to CAESAR 1I®

Required knowledge

This example assumes the user has already worked through the Beginner: Tank Blowdown example, or
has a level of knowledge consistent with that topic.

Model file

This example uses the following file, which is installed in the Examples folder as part of the AFT xStream
installation. This file can also be downloaded from the High Pressure Steam - Forces Example topic on
the Product Help Site:

* Metric - High Pressure Steam - Forces.xtr

Step 1. Start AFT xStream

Open AFT xStream. Click the Start Building Model button.

Step 2. Build the model

A. Place the pipes and junctions

This example will be created in the isometric view in order to get a greater feel for the pipe layout.
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From the Arrange menu, select the option to Show Grid

Open the Arrange menu again and select the Isometric option under Pipe Drawing Mode
Place the junctions as shown in Figure 1

Click the pipe tool and draw the pipes in the model as shown

Use the Rotate Icons button, or right click on the junction and select Auto-rotate Icon to align the
junction with the connected pipes. Alternatively, the Customize Icon option can be selected from
the right-click menu to manually choose an icon/orientation.

6. The grid can be shown or turned off in the Arrange menu, as shown in Figure 2

ok 0N~

Note: You can hold the "Alt" key while adjusting a pipe by the endpoint to add an additional segment .

This can be used with the arrow key or mouse scroll wheel to change between different preview
line options.

P - & O Oxe xOa-a= LYK=y - B ¢

TJ10
Turbine #1

Figure 1: Model layout with grid

e - &% B O x @-(|x[¢ @ -4

J2 ~

1
&1?
[
I )
o

J14

J1

High Pressure
= q} Steam Inlet

P ™ :
il B4 J4

5 P Vi

TJ12
Turbine #2

TJ10
Turbine #1 w

Figure 2: Model layout without Grid
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B. Enter the pipe data

The system is in place, but now the input data for the pipes and junctions needs to be entered. Double-
click each pipe or junction and enter the following data in the Pipe or Junction Properties windows.

All pipes in the model are User Specified and utilize a User Specified Friction Model with an Absolute
Roughness of 0.005 cm.

Pipe Internal Diameter (cm) | Length (meters)
1 33.6 4
2 33.6 12
3 27 4
4 27 4
5 27 10
6 27 13
7 27 2
8 27 1.5
9 20.5 6
10 27 1.5
11 20.5 6
12 16.5 15
13 16.5 3
14 16.5 3

C. Enter the junction data

1. Assigned Pressure J1

a. Name = High Pressure Steam Inlet

b. Elevation =0 meters

c. Static Pressure =16.7 MPa

d. Static Temperature =570 deg.C
2. BendJ2,J4

a. Elevation =0 meters

b. Type = Standard Elbow (knee, threaded)
3. AreaChange J3
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a.
b.
c.

Elevation = 0 meters

Type ="Conical Transition"
Angle =45 degrees

Bend J5, J7, J13

a. Elevation =4 meters

b. Type = Standard Elbow (knee, threaded)
Branch J6

a. Elevation =4 meters
Branch J8

a. Elevation =2 meters
Bend J9, J11

a. Elevation =2 meters

b. Type = Standard Elbow (knee, threaded)

Assigned Flow J10, J12

-~ ® 2 o T o

J10 Name = Turbine #1
J12 Name = Turbine #2
Elevation = 2 meters

Mass Flow Rate = 62.75 kg/sec (to each turbine)
Temperature =570 deg. C

On the Transient tab enter the following data for both Assigned Flow junctions:

Time Mass Flow ‘::::Li:;:
(seconds) | Rate (kg/sec) | P ) g
0 62.75 570
0.1 0 570
1 0 570
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Acsigned Flow Properties

Number- Upstream Pipe: o) of OK
Name |Turbina H1 ~ B3 Cancel
e Elevation
rary =
& Jump...
2 meters -~ .
Copy Data From Jct... ~ =
2 Help
Flow Model | [ Transient | Optional | DesignAlerts | Motes | Stetus

Transient Special Condtion [] Periodic Fow

(® None

() Ignore Transient Data

Transient Data
(@ Absolute Values
(O Relative To Steady-State Value

Dzta Time Mass Flow Static Temperature | A
kg/sec Point | (seconds) (kalsec) (deg. C)
1 0 62.75 570
Initiztion of Transient 2 0.1 0 570
®) Time (O Dual Event Cyclic 3 1 0 570
(O Single Event (O Dual Event Sequential 4
D
&
7
2
9
10
11
- .
[# EditTable ~| | Show Graph...

[1 Repeat Transient

W Transient

Figure 3: Transient data for Assigned Flow junctions J10 and J12

9. BendJ14
a. Elevation =7 meters
b. Type = Standard Elbow (knee, threaded)
10. Dead End J15
a. Name =Bypass Valve
b. Elevation =7 meters

D. Check if the pipes and junctions are specified
»Click the List Undefined Objects button to see if the model is fully defined. If it is not, the undefined

pipes and junctions window will show a list of incomplete items. If undefined objects are present, go back
to the incomplete pipes or junctions and enter the missing data.

Step 3. Specify Fluid

»Select Fluid from the Analysis menu to open the Fluid panel in the Analysis Setup window. For this
example, select the AFT Standard fluid option, then choose "Steam" from the list and click the "Add to
Model" button.
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Step 4. Specify the Pipe Sectioning and Output panel

»0Open the Pipe Sectioning and Output panel in the Analysis Setup window. Define the Minimum
Number of Sections Per Pipe as 1 section and the Estimated Maximum Pipe Temperature During Tran-
sient as 600 degrees C.

Analysis Setup X

[7®  Modules ~ ‘ Pipe Sectioning and Output

R N Mirimum Number of Sections Per Fipe: This valus s related to accuracy and rurtime. See the help file for detais

af
B  Pipes and Junctions ~ Estimated Maximum Pipe Fluid Temperature During Transient deg.C -
o

Pipe Sectioning and Output ~ Pipe Stations To Include In Transient Output Fle
© *Fipe Seclioning and Output O Inlet/Outlet Only
Al
#31  Transient Conirol A~ @
! Simulstion Mede/Durstion e
Shortest Ppe: 150 meters Estimated Total Steps: —
Transient Solver Initislization Ideal Section: 1.50 meters Total Statians: 58
o o Estimatsd Max Sonic Velooty: 675,83 meters/sec Estimated Total Ppe Computations: —
Estimated Time Step: 1108749203 seconds
AFT Armow ™ Steady =
30 Sotion v \u Sectioning Details ‘
e |E| Advanced Sectioning Centrols ‘
% Miscelloneous v
xStream Defauit
Callapse All Groups [ Same As Parent P Hep o oK Cancel

Figure 4: Sectioning panel for high pressure steam system in the Analysis Setup window

Step 5. Specify the Simulation Mode/Duration panel

»0Open the Simulation Mode/Duration panel from the Transient Control group. Enter the Stop
Time as 1 second. Click OK to close the Analysis Setup window.

Step 6. Specify Force Sets

We will first add one Force Set from the Workspace.

»On the Workspace, right-click on pipe P2 and from the right-click menu select "Create a Force Set
with Selected Pipe." Select the Use Pipe Information radio button and uncheck the "Include Appended
Text" option (Figure 5). Click Create. This will open the Force Definitions panel of the Analysis Setup win-
dow. The Force Definitions panel should appear as shown in Figure 6.

AFT xStream can only determine axial forces down a pipe in the direction defined as forward by the force
set definition. As such, AFT xStream has no knowledge of the three-dimensional orientation of a given
force set. For example, a vertical pipe and a horizontal pipe that both have the same force magnitude
would be indistinguishable in AFT xStream. The force set definition informs the sign of the force, with a
positive value indicating a force pushing from the start location to the end location, and a negative value
indicating the converse.
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If a more robust view of the 3D orientation of the pipes is required, directional information can be entered
using the optional Force Unit Vector columns. The Force Unit Vectors do not impact AFT xStream's cal-
culations, but may be useful to export the output to piping stress analysis software as discussed in Step
12

Note: Only single pipes can be added as a "Difference" force set type from the Workspace. Also note
that difference forces should strictly be used between two 90 degree angle pipe fittings.

Create Force Set

Example Force Set Name
| P2

() Use Upstream/Downstream Junction Names
() Use Upstream/Downstream Junction Numbers
(® Use Pipe Information

Include Pipe Name

[ Include Appended Text

¥ Force Unit Vectors or Length

Show Analysis Setup Force Definitions after Creation

You will be creating 1 force set.

Lo Create Ed cancel 2 Help

Figure 5: Adding force set from Workspace using the right-click menu

| o Moddes v | Forces
@®  Flud Properties v 7 a a
& H x 4 = L] Generate
f €  Pipes and Juncions v New Duplcate Delete Delete Al || Swap Nodes | Import from CSV. Force Names Reorder Force Sets: | ) &
Force Set Name Force Start Length To Start Station End Length To End Station Fipe Edt
410 Pipe Sectioning and Output Type Pipe Start Node (Actual Length in Pipe End Node (Actual Length in Group Area
(meters) (meters)) (meters) (meters)) (metersz
&  Transient Contral v I Difierence |~ 2lv Inlet|~ 000 2v Outiet v B3] NA
3P Forces A
“Force Definitions
AFT Arrow ™ Steady o
3® Solsion
@9  Environmental Properies
5B Miscellancous v
< >
Point Force Ambient Pressure
Bdt Area Unts: | meters2 e @ Use Atmospheric Pressure From Environmental
O User Specfied
Ambient Pressure Unts: |
Collapse All Groups A SameAsPaent -| D Hep oK E3 Cancel

Figure 6: High Pressure Steam System Force input in the Analysis Setup window

The remaining force sets will be defined inside the Force Definitions panel.

»Define a force set by clicking "New", selecting the Force Type (in this example, we will be using "Dif-
ference"), entering a name, and defining the starting and ending locations of the force set. Set up the
force sets as shown in Figure 7. Click OK to exit the Analysis Setup window.
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Analysis Setup X
|79 Moduies o=
@®  Flud Properties v 7 a a
@ Y x a = LY Generste
B  Pipes and Junctions v New Duplicate Delete Delete Al Import from CSV. Force Names Reorder Force Sets: | {| &
Force Set Name Force St | LengthTo Start Station End | LengthTo End Station Fipe it
410 Pipe Sectioning and Output Type Pipe Start Node (Actual Length in Pipe End Node (Actual Length in Group Area
(meters) (meters)) (meters) (meters)) (metersz
&  Tramsient Conirol v T e Difference |~ 2~ ket~ 000 2v Outlet v B(2937) A | ]
5 2 |, Difference | 3lv Inlet|> 0o 3lv Outiet v 3(1212) NA I
3P Forces A A
3 | Difirence |~ 4w Inlet| 000 4v Outlet| v 3a12) NA ]
“Force Definitions 4 |pspe Difference | 5 et 000  6lv Outiet v 9(4265) N |
AT e 5 |p7 Difference | 7|v Inlet| v 000)  7lv Outlet v 1(656168) NA | ]
3® Solsion v
@9  Environmental Properies
5B Miscellancous v
< >
Point Force Ambient Pressure
Bdt Area Unts: | meters2 e @ Use Atmospheric Pressure From Environmental
O User Specfied
Anmbient Pressure Units: 2
Collapse Al Groups o SameAsPaent -| (D Hep oK E3 Cancel

Figure 7: Completed Forces panel in the Analysis Setup window

Step 7. Add child scenarios using Scenario Manager

A. Create scenarios

In this model, we will evaluate three different valve closure durations for the system:

1. 0.1 Second Valve Closure
2. 0.25 Second Valve Closure
3. 0.5 Second Valve Closure

We will create three child scenarios to model the three cases.

»Go to the Scenario Manager on the Quick Access Panel. Create a child scenario by either right-
clicking on the Base Scenario and then selecting Create Child, or by first selecting the Base Scenario on
the Scenario Manager on the Quick Access Panel and then selecting the Create Child icon “  Enter
the name "0.1 Second Valve Closure" in the Create Child Scenario window, and click OK. The new "0.1
Second Valve Closure" scenario should now appear in the Scenario Manager on the Quick Access Panel
below the Base Scenario.

»>Right-click the Base Scenario in the Quick Access Panel. Create another child and call it "0.25
Second Valve Closure". Finally, create one more child and call it "0.5 Second Valve Closure". The child
scenarios should now be displayed as shown in Figure 8.
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Scenanio Manager o

& Base Scenario

i ® 0.1 Second Valve Closure
i @ .25 Second Valve Closure
‘.. ® 0.5 Second Valve Closure

Figure 8: Completed Scenario Manager for High Pressure Steam - Forces

B. Define the child scenarios

Since the "0.1 Second Valve Closure" scenario uses the same transient definitions as the base scenario,
we do not need to modify it. We will set up the remaining scenarios using the following steps:

1.  Open the "0.25 Second Valve Closure" scenario by double-clicking the name in the Scenario Man-
ager

2. Open the Assigned Flow Properties window for Assigned Flow J10 and open the Transient tab.
Enter the following data:

Time (seconds) | Mass Flow(kg/sec) | Static Temperature (deg. C)
0 62.75 570
0.25 0 570
1 0 570

3. Enter the same Transient Data for Assigned Flow J12
4. Open the Child Scenario "0.5 Second Valve Closure" from the Scenario Manager

5. Open the Assigned Flow Properties window for Assigned Flow J10 and open the Transient tab.
Enter the following data:

Time (seconds) | Mass Flow(kg/sec) | Static Temperature (deg. C)
0 62.75 570
0.5 0 570
1 0 570

6. Enterthe same Transient Data for Assigned Flow J12

Step 8. Compare child scenarios using the Scenario Comparison Tool

The three scenarios created should be identical except for the different transient data. To confirm the
scenarios are otherwise identical, we will use the Scenario Comparison Tool.

1. Load the "0.1 Second Valve Closure" scenario from the Scenario Manager
2. Inthe Tools menu, select the Scenario Comparison Tool
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3. Inthe Scenario Comparison - Selection window (Figure 9), select "Siblings"

4. Click "Show Comparison"

5. Inthe Scenario Comparison Grid, set the "ltem" and "Parameter” sliders to show "Differences".
Also set the "Highlight Unique Values" slider to "Yes".

The Scenario Comparison Tool will run a comparison of all Pipe and Junction Properties as well as the
General Properties used in each scenario and highlight any differences in the Scenario Comparison
Grid. In this model, the only highlighted differences should be for the "First Transient Data" parameter for
junctions J10 and J12 (Figure 10). Note that each column in the Scenario Comparison Grid is highlighted
in a different color. This indicates that each scenario possesses a unique value for the given parameters.

Click close to exit the Scenario Comparison Tool.

I Scenario Comparison - Selection

[e] L]
Lol
asl
O g

Siblings

Select Scenarios to Compare

Ol

Ancestors Exhaustive Custom

® Base Scenaro
EA€ 0.1 Second Valve Closure
® 025 Second Valve Closure
® 05 Second Valve Closure

Al None || Invert | 3of 4 selected

Highlight Unique Values
No ® Yes

HIENE

4 Select Pipe and Junciion Properiies (32 of 32 pij

/& Select General Properties (11 of 11)

ies. 87 of 87 junction

3 Select Pipes and Junctions (14 0f 14 pipes, 15 of 15 junctions)

P Hep

I8 Show Comparison

® Close

Figure 9: Scenario Comparison Tool - Selection window

It Scenario Comparisen - Comparison Grid

Ttem
Show
Differences  ® Al
= Pipes (14 of 14 compared) - No Differences
- Junctions (150f 15

Show
Differences @

Parameter

Al

0.1 Second Valve Closure

0.25 Second Valve Closure

Scenario

0.5 Second Valve Closure

410 (Turbine 1)

First Transient Data

Yes - Table]

Yes - Table]

Yes - Table

112 (Turbine #2)|
Modules (10of 1 compared) - No Differences
Fluid Properties (5 of 5 compared) - No Differences
Pipe Sectioning (3 of 3 compared) - No Differences
Transient Control (1 of 1 No Di
Steady Solution Control (3 of 3 compared) - No Differences
Environmental Properties (2 of 2 compared) - No Differences
(11 No Differences

First Transient Data

Yes - Table|

Yes - Table|

Yes - Table

ftem Parameter |
| Al Parameters Same Value | Same Value Across Scenarios |
[ At Least 1 Parameter Difference | Different Values Across Scenanos |

No

Yes

Qrly parameters with diferences will bz shown. f al chosen parameters for an tem are the same, then the item wil be hidden
Parameters cantaining tabular data (2.g. polynomial corstants) can be viewed by right<licking the parameter's row.

Highlight Unique Values

Sy Copy

P Help I Modify Comparison

ELE

® Close

Figure 10: Scenario Comparison Grid of the 3 scenarios
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Step 9. Run the first scenario

»Double-click the "0.1 Second Valve Closure” child scenario in the Scenario Manager. Ensure
that all force sets are set to be applied in the Force Definitions panel of the Analysis Setup window as
shown in Figure 7. Select "Run Model" from the Analysis menu. This will open the Solution Progress win-
dow. This model has an estimated run time of 1 minute, but the run time is dependent on the speed of
your computer.

Step 10. View the results

A. Open the Forces tab

»In the Output window, click on the Forces tab. This will show the maximum force observed in the
defined force sets, as well as provide information about how the force segments were defined.

A | Pipes Axial Points = Transient Output = TransientMax/Min = Heat Transfer | Forces

Set | Maximum | Max Abs Start Start Pipe | End Pipe | End Pipe

Mame | Absclute Time Fipe ID Station D Station
(N (seconds)
1 |P2 30139 0.15536 P2 0 P2 g
2 |P3 5532 0.14582 P3 0 P3 3
3 |P4 8751 0.14538 P4 0 P4 3
4 |P5-PE 30733 0.10876 PS 0 P& 9
5 |P7 2818 0.07657 F7 0 P7 1

Figure 11: Forces tab in the Output window for the "0.1 Second Valve Closure"” scenario

B. Graph the force results

»Open the Graph Results window. We will create a graph that shows the transient forces over time for
the force sets. To do so, perform the following steps:

Select the Forces tab on the Graph Control tab on the Quick Access Panel, as shown in Figure 12.
Select "All" force sets to be graphed.

Verify the Force Units Primary Y is setto "N."

Verify that Time Units is set to "seconds."

Verify that the Time Frame is set to "All times."

Click Generate.

2N

This should generate the graph shown in Figure 13.

Add the graph to the Graph List Manager by right-clicking the graph results window and selecting "Add
Graph To List...". Name the graph "Force Sets" and click OK.
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ﬂ Transient Pipe H Transient Jct Profile L4 Forces
Force Sets: Graph Selected Force Sets:
Al P2
MNone P4
Invert P5-P&
nve: i
Details
Multi-Scenario... ~ | |Cument Only
Force Units Primary Y: | N -
Force Units Secondary Y: | none -
Time Units: | seconds @
Time Frame: | @) Al Times () User Specified

Figure 12: Graph parameters for force sets

Graph Resulis o x

1% What Would You Like to Do?

Force vs. Time

40000

30000 /\
20000
7N
= 10000 /\
o 7 N / ~\
] 0 / .
2 /’ ~. P2
-10000 \ P3
| P4
-20000 P5-P6
P7
-30000
0 0.2 04 0.8 0.8 1
Time (seconds)
B x &+ ¥~

Base Scenario/0.1 Second Valve Closure

Figure 13: Graph for forces of the "0.1 Second Valve Closure” scenario

Note that at t = 0 seconds, there are no force imbalances for any of the force sets. This is expected since
the sum of forces across a piping run between two elbows equals zero in a steady state system. If a Point
or Exit type force set were used instead of a Difference type force set, then a non-zero force may be
encountered during the steady state.

Additionally, some traditional methods of analyzing force sets will not yield the same results as AFT
xStream since they may not include friction or momentum effects in their force balances. Traditional
methods can yield significantly different results and indicate incorrect, non-zero forces during steady
state conditions.

There are two important points to be observed here:
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1. AFT xStream calculates transient fluid forces. This does not include piping, component, or fluid
weight, or any other forces external to the piping. A comprehensive analysis of pipe loading must
separately include these items.

2. Ignoring friction and momentum force balance components will result in force imbalances that do
not exist.

Step 11. Run the other child scenarios

»Run the other two child scenarios and load the Forces tab and the "Force Sets" graph list item for each.
The results are seen below in Figures 14-17.

»

Pipes | Axial Points | Transient Output | Transient Max/Min = Heat Transfer | Forces

Set Maximum | Max Abs Start Start Fipe | End Fipe | End Pipe

Name | Absolute Time Fipe 1D Station 1D Station
(M) (seconds)
1 [F2 12,598 0.2242 P2 0 F2 8
2 |P3 4,076 0.2215 P2 0 P3 3
3 (P4 3.952 0.2153 P4 0 P4 3
4 |P5-P& 20722 0.2009 P5 0 P& 9
5 |P7 1478 0.1964 P7 0 P7 1

Figure 14: Forces tab in the Output window for "0.25 Second Valve Closure” scenario

Graph Results o x

5 | f= & = Q | = | & £ What Would You Like to Da?

Force vs. Time

30000

20000

10000

Force (N)

s N/ S
-10000 | [ P4

P5-P6
P7

0 0.2 0.4 0.6 0.8 1
Time (seconds)

Base Scenario/0.25 Second Valve Closure

Figure 15: Graph for forces of the "0.25 Second Valve Closure" scenario
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%  Pipes Auial Points Transient Output = Transient Max/Min = Heat Transfer | Forces
Set | Maximum | Max Abs Start Start Pipe | End Pipe | End Pipe
Name | Absolute Time Fipe|D | Ststion 1D Station
(M) (seconds)
1|F2 5.880.0 02186 F2 0 F2 g
2 |P3 1.805.5 02186 P3 0 P3 3
3 |P4 18782 02109 P4 0 P4 3
4 |P5-P& 9.964.6 0.1986 P5 0 P& 9
5 |P7 7241 0.1953 P7 0 P7 1

Figure 16: Forces tab in the Output window for the "0.5 Second Valve Closure"” scenario

Graph Results o x

T
i
i

3 |- & o B # | & 48 What Would You Like to Do?

N
B | 53 e

Force vs. Time

10000

8000

6000

4000

: YA
< 2000 =
pe . —_\
5 0 I\ \
I \ - P2
-2000 P3
-4000 \ P4
6000 P5-P6
P7
-8000
0 0.2 0.4 0.6 0.8 1
Time (seconds)
BB x L I

Base Scenario/0.5 Second Valve Closure

Figure 17: Graph for forces of the "0.5 Second Valve Closure” scenario

These figures show that the maximum force magnitude increases as the valve closes faster. Typically,
the more rapidly a change occurs, the more severe the resulting forces are. Therefore, a utility of AFT
xStream would be to evaluate the correlation between transient event duration (e.g., valve closing time)
and the resultant force magnitudes.

Factors affecting the timing and magnitude of forces

Pipe sectioning, the selection of fluid property model, and specification of Maximum Pipe Mach Number
During Transient can have a significant effect on the accuracy of the forces calculated by AFT xStream.
This effect was not significant in the system built within this example. However, the results for altering
each of these three parameters are shown in Figures 18-20 so that you may see the impact of changing
these three parameters. Note that in Figure 19, ASME Steam, Chempak, and NIST REFPROP are super-
imposed on each other, indicating no meaningful difference for this case.

If you wish to learn more about the effect of altering these 3 factors with regards to force, the click here to
go to the Transient Sensitivity Analysis Tutorial.
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Graph Results o x

g BhEE e D Q. o 15 What Would You Like to Do?

Force vs. Time

15000

10000 | / /\ \ p ;
/ \ \ /

5000

Force (N)
e

-5000 “\ J )
1 Section - P2 . / \\/
i '

10000 1 [7] 10 Sections - P2 &u/ W
20 Sections - P2
15000
0 0.2 0.4 0.6 0.8 1

Time (seconds)

B x @ 5o

Figure 18: Effect of sectioning on High Pressure Steam - Forces model. All runs use the AFT Standard fluid
library and a Maximum Pipe Mach Number During Transient of 1.

Graph Results o x

Ee | oM @ = B | ] |- | & o & What Would You Like to Do?

Force vs. Time

15000

10000 }/‘
5000
~5000 AFT Standard - P2

Chempak - P2

-10000 NIST REFPROP - P2
ASME Steam - P2

0 0.2 0.4 0.6 0.8 1
Time (seconds)

B x @ 5o

Figure 19: Effect of fluid property model on High Pressure Steam - Forces model. All runs use a Minimum
Number of Sections Per Pipe of 1 and an Estimated Maximum Pipe Mach Number During Transient of 1.

Force (N)
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Graph Results o x

[ fie=) & = 8 |- | & o % What Would You Like to Do?

i
i
3

N
B | 5a e

Force vs. Time

15000

N /94\\
10000 e \ - £
) ! A
—~ 5000 J Y //
:J’ 0 / | J \ / .
0 \ /
\ / N,
-10000 \'\;//,/ \\ \/,/
-15000
0 0.2 0.4 0.6 0.8 1

Time (seconds)

1 Section, Max Mach # = 1 - P2
20 Sections, Max Mach # = 1 - P2
1 Section, Max Mach # = 0.2 - P2

B x & ¥ -
Figure 20: Effect of Maximum Pipe Mach Number During Transient on High Pressure Steam - Forces model.
All runs use the AFT Standard fluid library.

Step 12. Export CAESAR Il Force file

> O0pen the Output window, and click on the File menu. Select "Export Force File..." and choose
"CAESAR II® Force File." This will open the export file window shown in Figure 21.
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Export CAESAR II® Force File
List of Force Sets
. Force Unit Foret
‘wirite To . Length to Start . Length to End Ambient
File | ForceSetName | ForceType | SrtFipe | “joge fjeer) | EndPiPe | “Noge (feef) | Pressure fatm) | ycuector | | Vet
P3 Difference 3 0 3 Outlet [
P4 Difference 4 0 4 Outlet [
P5-PE Difference 5 0 6 Outlet [
P7 Difference 7 0 7 Outlet [ ]
< >
Mone || Invert |
Force File Time Frame Fiter Force File Data
(® Al Times (®) Wrte Data to Fle Every Time Step
() User Spectied Time Frame (O Write Intermediate Data To File Every |2 Time Steps
Force File Output Units Force Analysis Type
Force: |N - (® Spectrum Analysis
Time Step Size (seconds): 0.00111 T (O Time History Analysis
Transient Qutput Frequency: Every 1 Steps ime: | seconds ~
{From Transient Corttral} 4k Export Force File
Time: Units: | seconds ot Force File Data Points @ L
Force Sets Selected: 5 Number of Data Points: 302 =
[] Export Unit Vector v Help

Figure 21: Export CAESAR II® Force File window

The force sets to include in the force file may be individually selected, along with how frequently data
points are saved. The number of data points that will be in the file is also displayed for the given setting.
This number should not exceed the maximum number of data points allowed for the relevant piping
stress software, which in the case of CAESAR I1® is 2500.

If unit vector information has been entered in the Force Definitions panel, the Export Unit Vector option
can be used to include this information in the exported file. Similar methods to those described above can
be used to export force files to ROHR2®, TRIFLEX®, and AutoPIPE®.

Conclusion

We created a force model to calculate the forces experienced as a result of two simultaneous closures in
a steam header. We also identified how the length of the transient can have a significant impact on the
forces a system experiences. Finally, we discussed how to export these forces into a force file to be used
in pipe stress analysis software.
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Summary

A frequency analysis is performed on a system with a positive displacement compressor to determine the
acoustical frequencies that need to be evaluated for the existing piping configuration.
Topics covered

* Using the PFA module to identify natural acoustic frequencies
* Defining valid sectioning and simulation duration settings for pulsation analysis
* Checking API-618 compliance

Required knowledge

This example assumes the user has already worked through the Beginner: Tank Blowdown example, or
has a level of knowledge consistent with that topic.

Model file

The file listed below contains a completed version of this example and can be located in the Examples
folder as part of the AFT xStream installation. This file can also be downloaded from the AFT xStream
help site from the Frequency Analysis - PFA Example page:

* Metric - Frequency Analysis PFA.xtr

Step 1. Start AFT xStream

Open AFT xStream. Click the Start Building Model button.

From the Startup window under the "Activate Modules" section in the center panel, select the PFA (Pulsa-
tion Frequency Analysis) option to activate the PFA module. If AFT xStream is already running, choose
Activate Modules from the Tools menu, then check the box next to PFA to activate the module on the
Modules panel.

-91 -



AFT xStream Add-on Module - PFA Example

Step 2. Build the model

A. Place the pipes and junctions

The next step is to define the pipes and junctions. In the Workspace window, assemble the model as
shown in Figure 1.
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Figure 1: Layout of frequency analysis model

B. Enter the pipe and junction data

The system is in place but now we need to enter the input data for the pipes and junctions. Enter the fol-
lowing data:

All Pipes are Steel - ANSI, STD (schedule 40), and have standard roughness. The rest of the pipe inform-
ation is as follows:

Pipe # Length (meters) | Size (inches)
1 8 10
2 8 10
3 8 10
4 80 16
5 3 6
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1. Assigned Flow J1
a. Elevation = 3.5 meters
b. Name =PD Compressor
c. Mass Flow Rate =40 kg/sec
d. Temperature =38 deg.C

2. Valve J2
a. Elevation =3.5 meters
b. K,=385
c. X{=038
3. BranchJ3
a. Elevation = 3.5 meters
4. Valve J4
a. Elevation =0 meters
b. K,=1380
c. X=06

5. Assigned Pressure J5
a. Elevation =0 meters
b. Stagnation Pressure =0 barg
c. Temperature =38deg.C
6. DeadEndJ6
a. Elevation = 3.5 meters
b. Name = Closed Valve

C. Check if the pipe and junction data is complete

»Turn on List Undefined Objects from the Main Toolbar to verify if all data is entered. If it is not, the
undefined pipes and junctions window will show a list of incomplete items. If there are undefined objects,
go back to the incomplete pipes or junctions and enter the missing data.

Step 3. Specify Analysis Setup

A. Specify the Fluid panel

»0Open the Analysis Setup window and select the Fluid panel under the Fluid Properties group. Under
the "AFT Standard" fluid option, choose "Methane" from the list and click the "Add to Model" button. Click
OK.
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B. Specify the Pipe Sectioning and Output panel

»O0Open the Pipe Sectioning and Output panel in the Pipe Sectioning and Output group. Define the
Minimum Number of Sections per Pipe as 8 sections and the Estimated Maximum Pipe Temperature Dur-
ing Transient as 65 deg. C.

C. Specify the Simulation Mode/Duration panel

»0Open the Simulation Mode/Duration panel in the Transient Control group. Enter the Stop Time as 2
seconds.

D. Specify the Pulse Setup panel

»O0pen the Pulse Setup panel from the Pulsation Setup group. The Pulse Setup panel is used to spe-
cify the location and magnitude of the pulse applied to the system, as well as the parameters required to
generate the forcing function for frequency analysis.

Define the Pulsation inputs as follows (Figure 2):

1. Check that junction J1 is selected for the pulse to be applied at. Note that the pulse may only be
applied at Assigned Flow or Compressor junctions.

2. For Magnitude, ensure that Automatic (Twice Steady-State Flow) is selected.

3. Under Frequency Analysis, define the Cutoff Frequency as 200 Hz and verify that the Minimum
Number of Frequency Samples is set to the default value of 1000.

4. Leave the Evaluate with API-618 option unchecked. This option will be used in a later step once
the acoustic frequencies have been determined.
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Analysis Setup X
[i®  Modules ~ | Pulse Setup
@@  Fluid Properties ~ Pulse Properties
= Pipes and Junciions v Applied At: | J1 (PD Compressar) ~
Steady-State Flow: 40.00 kg/sec
45  Pulsation Setup ~
Magnitude
© “Pulse Setup (®) Automatic (Twice Steady-State Flow)
User Specilied: ko
{0  Pipe Sectioning and Ouiput ~ o & s
Peak: 80.00 kg/sec
{9  Transient Control ~
Frequency Analysis
50  Foces ~
Cutoff Frequency: He
AFT Armow ™ Steady o
#P  Sohion Minimum Number of Frequency Samples: | 1000
£9  Environmental Properies
[ Evaluate with API-618
E®  Miscellaneous v
seconds
Pulsation Summary
Minimum Sections Minimum Simulation Duration
Curert Count: 8 Curent Duration: 2 seconds
Detectable Frequency: 1262.84 Hz Actual Samples: 2525
Required For Cutoff: 2 Required For Min. Samples: 0.79 seconds
Collapse All Groups T Same As Parent P Hep o OK B3 Cancel

Figure 2: Pulse Setup panel in the Analysis Setup window with all pulsation settings defined

Now that all of the pulsation inputs are defined, look at the Pulsation Summary at the bottom of the win-
dow. The defined Cutoff Frequency and the Minimum Number of Frequency Samples will affect the num-
ber of sections and the simulation duration that are required to run the analysis. If the number of sections
is insufficient, then the time step will be too large to capture the specified Cutoff Frequency. Similarly, if
the simulation duration is too small, then the number of time steps will not accommodate the Minimum
Number of Frequency Samples.

Checking the Pulsation Summary for this example, the Minimum Sections Required for Cutoff are 2, and
the Minimum Simulation Duration Required for Min. Samples is 0.79 seconds. Both of these require-
ments are satisfied by the current model settings. The "Update For Me" button can be used to auto-
matically change the minimum number of sections and/or the minimum simulation duration if they are
insufficient. Click OK to exit the Analysis Setup window.

Step 4. Run the model

»Select "Run Model" from the Main Toolbar. This will open the Solution Progress window. This model
has an estimated run time of 5 minutes, but the run time is dependent on the speed of your PC.

Step 5. Review the frequency results

»O0pen the Graph Results window. The first step will be to generate a plot of the pressure in each of
the pipes to ensure that the simulation duration was long enough for the response to stabilize. Create the
pressure graph as follows:

1. Select the Transient Pipe tab in the Graph Control tab in the Quick Access Panel
2. Addthe inlet and outlet station for each of the pipes
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3. Under Select Parameter choose "Pressure Static" and verify "bar" are the selected units
4. Click Generate

The pressure graph should appear as shown in Figure 3. Note that there is a small perturbation in the
pressure when the pulse is applied to the system, though the pressure results completely stabilize by the
end of the run. If the pressure results were still changing at the end of the run, the model should be re-run
with a longer simulation duration.

Graph Results o x
=By & B e e = ] o £ What Would You Like to Do?
Pressure Static vs. Time

30
A
25
o
_8 20
o Static Pressure - P1, Sta. 0 (Inlet) [v] Static Pressure - P1, Sta. 21 (Outlet)
= Static Pressure - P2, Sta. 0 (Inlet) [v] Static Pressure - P2, Sta. 21 (Outlet)
s Static Pressure - P3, Sta. 0 (Inlet) [v] Static Pressure - P3, Sta. 21 (Outlet)
g Static Pressure - P4, Sta. 0 (Inlet) [v] Static Pressure - P4, Sta. 213 (Outlet)
u Static Pressure - P5, Sta. 0 (Inlet) [v] Static Pressure - P5, Sta. 8 (Outlet)
E 10
5
0
0 0.5 1 1.5 2
Time (seconds)
d B =x + 5 -

Figure 3: Pressure Static in each of the pipes for the frequency analysis

Next, graph the acoustic frequency response as follows:

Click the "New Tab" button

Select the Frequency tab in the Graph Parameter section of the Quick Access Panel (Figure 4)
Add the inlet and outlet station for each of the pipes

Verify that the pressure units are set to bar

Click Generate

ok wbd -~
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) Parameters .,;f°F:-rn'Et'tir: >
ﬂ Transient Pipe Transient Jct HEr:-ﬁIe ﬂ Frequency
Select Pipe Stations: Graph These Pipes/Stations:
_ -4 (Pipe) ~ F1 Inlet
. P1 Outlet
- Quttlet == E% giﬁ’l[et
i [~ Other Stations o= || P3 Inlet
=- 5 (Fipe) P3 Outlet
L Inlet - P4 Inlet
- Outlet e O
+- Other Stations == P5 Outlet
v
Pressure Units: | bar <
Flow Units: | None -
o Gererate -

Figure 4: Graph Parameters section for the frequency analysis

Identify excitation frequencies to study

From the graph in Figure 5, there are several frequencies that produce a large pressure response. Points
on the plot with a large response magnitude are easily identified by finding local maxima on the graph.
These maxima are the acoustic natural frequencies that are potentially the most damaging when excited
by a positive displacement compressor. These frequencies can also be caused by equipment that con-
tributes large pressure drops, such as control valves.

Two natural frequencies are identified for the system based on the peaks in the graph at roughly 27 Hz
and 54 Hz. Note that the number of sections used for the analysis may affect the location of the peaks, so
it is prudent to run the analysis with more sections to reduce uncertainty in the results. It is also recom-
mended to analyze frequencies near identified peaks (for example, analyzing 52 and 56 Hz for the peak
at 54 Hz) to account for potential shifting of the frequency peaks that can result from the assumptions
made for the frequency analysis in AFT xStream.
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Figure 5: Acoustical frequency graph for the positive displacement compressor system

Step 6. Determine the pressure response for API1-618

The identified excitation frequencies can now be used to determine the pressure response in the system
caused by the pulsation at the compressor. The pressure response can then be evaluated for com-
pliance with API-618.

To determine the pressure response of the excitation frequencies, complete the following steps:

1. Inthe Scenario Manager, right-click on the base scenario and choose "Create Child". Name the
child scenario "27 Hz".

2. Open the Analysis Setup window and go to the Pulse Setup panel.

3. Check the box to "Evaluate with API-618 and enter the Speed as 810 rpm and the Number of
Heads as 2.

4. Enter the Time Until Steady State Pulsation as 0.15 seconds. The method to find this value is dis-
cussed later in the example. Click OK to close Analysis Setup.

5. Open the Assigned Flow Properties window for junction J1.

6. Inthe Transienttab, clear the pulse transient data by clicking Edit Table under the transient table
and choosing Clear All Data.

7. Check the box next to Periodic Flow. Define the Frequency as 27 1/s and the Flow Amplitude as 5
kg/sec (Figure 6).

8. Click OKto close the Properties window.
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Assigned Flow Properties

Number: o OK
Name: |PD Compressor v| Eongsteanlbss L E3d Cancel
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Copy Data From Jct... - -
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Flow Model | [ Transient | Optional | DesignAlerts | Motes | Status
Transient Special Condition Periodic Flow Transient Data
® Mone [] Chopped Sine Wave (® Absolute Values
(O lgnore Transient Data Frequency (1/s) ; () Relative To Steady-State Value
Flow Amplitude: Diata Time Mass Flow Static Temperature | &
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® Time (O Dual Event Cyclic 3
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12 v

[ EdtTable =| | Show Graph...
[] Repeat Transient

ﬂ] Transient

Figure 6: Assigned Flow Properties window with Periodic Flow transient applied

The model is now updated to represent the pulsation at the positive displacement compressor that will
excite the system. Run the model, then navigate to the Output window. This scenario will run faster than
the base scenario (about 2 minutes).

In the Output window there is now a warning stating that the maximum pressure limit for API-618 was
exceeded as is shown in Figure 7. When the API-618 evaluation is performed the Pulsation Summary tab
is shown in the Output window with additional information on where pressure limit violations occurred,
and what inputs were used to calculate the API-618 pressure limits for the scenario (Figure 8).

A

# | General | Warnings | Design Alerts | Applied Standards = Sonic Choking = Event Messages By Jet | Event Messages By Time | Pulsation Summary | Walve Summary
Messages
For an explanation of Wamings. click an item in this list and press F1 or search for Wamings' in the Help system_
+~ WARNING
The maximum pezk-to-peak pressure limit defined in the AFI-618 standard has been excesded 3t 38 location(s). See the Pulsation Summary.

Figure 7: Warning showing that the API-618 pressure limits have been exceeded at multiple locations
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A | General  Warnings = DesignAlerts = Applied Standards = Sonic Choking | Event Messages By Jct | Event Messages By Time | Pulsation Summary | Valve Summary
""" Checking API-618 Pulsation and Pressure Limits =" ~
““WARNING™" The maximum peak to-peak pressure limit has been exceeded at 38 location(s).

The 10 most severe locations are:

Pipe 1 station 21: maximum peak4o-peak pressure limit = 274 kPa at frequency 27.0 Hz. Actual peak+o-peak pressure = 145 kPa ( 527% of the limit).

Pipe 1 station 20: maximum peak{o-peak pressure limit = 27.4 kPa at frequency 27.0 Hz. Actual peakto-peak pressure = 143 kPa ( 5207% of the limit).

Pipe 1 station 0: maximum peako-peak pressure limit = 27.5 kPa at frequency 27.0 Hz. Actual peakto-peak pressure = 147 kPa { 513% of the limit).

Pipe 1 station 1: maximum peak-to-peak pressure limit = 27.5 kPa at frequency 27.0 Hz. Actual peak-to-peak pressure = 139 kPa ( 505% of the limit).

Pipe 1station 19: maximum peak-to-peak pressure limit = 27.4 kPa at frequency 27.0 Hz. Actual peak-to-peak pressure = 138 kPa ( 502% of the limit). v
< >

Figure 8: Pulsation Summary tab listing the pipes with the largest pressure violations

In the Graph Results window, generate a graph of the static pressure following the same process used to
create Figure 3. However, only include the pipe P1 inlet and outlet station. The resulting graph is shown
in Figure 9. These pressure results can be used to check for compliance with standards such as API-618.

The pressure results for the compressor outlet (Pipe P1 inlet) can also be used to determine the Time
Until Steady State Pulsation, which is one of the inputs needed to accurately evaluate API-618. The Time
Until Steady State Pulsation is the time at which the pressure oscillations have a consistent amplitude. In
Figure 9 below the wave heights appear to become consistent at about 0.25 seconds.

Note for this example the value of 0.25 seconds was given in advance to expedite the process, but nor-
mally the user would need to run the model once with the "Time Until Steady..." set to 0, then determine
the time input and re-run the model with the correct value.

For comparison, this model can also be run at one of the frequencies which gave a lower amplitude, such
as 14 Hz. At 14 Hz, a lower amplitude pressure response is produced, as can be seen in Figure 10.

Note: The pulsation observed in this model represents a pure sine wave. Real systems might have a
different forcing function.
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Figure 9: Pressure Static response at 27 Hz frequency
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Figure 10: Pressure Static response at 14 Hz frequency
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Conclusion

The PFA add-on module for AFT xStream can be used to apply a pressure pulse to the system in order to
identify acoustic frequencies which may result in damage. These frequencies can be used in further
pulsation analysis to determine if pulsation mitigation is required, and what mitigation would be effective.
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